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Copyright 

© 2010 Itron, Inc. All rights reserved. 

 

Confidentiality Notice 

The information contained herein is proprietary and confidential and is being provided subject to the condition that (i) it be held in confidence except to the extent required otherwise by 
law and (ii) it will be used only for the purposes described herein. Any third party that is given access to this information shall be similarly bound in writing.  

Trademark Notice 

Itron is a registered trademark of Itron, Inc. Dattus is a registered trademark of Itron, Inc. PCLink is a trademark of Itron, Inc. 

All other product names and logos in this documentation are used for identification purposes only and may be trademarks or registered trademarks of their respective companies. 

Regulatory Notices 

Intrinsic Safety for Hazardous Locations 

Dattus Gas Meter design conforms to the UL, CSA ratings of Class 1 Div 1 group C&D and Class 1 Div 2 hazardous locations. 

The meter is approved to the CENELEC standards for rating of an IIB T4. 

The intrinsic safety includes design constraints on the batteries, electronic board, outputs, and external plastic surfaces.  

Contact 

 Internet: www.itron.com 

 E-mail: support@itron.com 

 Phone: 1 800 635 8725 

 

Itron, Inc. 
Gas Division - U.S. 
970 Highway 127 North 
Owenton, Kentucky 40359-9302 
Phone: (502) 484-5747 
Toll Free: 1-800-490-0657 
Fax: (502) 484-6223 
Email: Dattus@itron.com 

  

Suggestions 

If you have comments or suggestions on how we may improve this documentation, send them to TechnicalCommunicationsManager@itron.com 

If you have questions or comments about the software or hardware product, contact Itron Technical Support: 
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This Technical Reference Guide provides Dattus Meter hardware and software related 

information.  The following document conventions apply to this reference guide. 

Document Conventions 
 

 

Note  A Note provides essential information about using the Technical 

Reference Guide. 

 

Caution  A Caution provides information that is important to consider when 
performing certain operations. 

 

Warning  A Warning provides special, must-read information. If you ignore 
a warning, you may omit essential data or make a critical error that could 
cause bodily harm or severely damage the meter.  

 
 

General Information 

This technical reference guide provides hardware and software installation and operation 

information for the following Itron Dattus® fM2 and fM3 base model gas meters: 

 Basic-L 

 Basic-EXT 

 ETC-L 

 P-only 

 PTZL 

 

       Dattus Basic fM2                         Dattus Basic fM3 

C H A P T E R  1  

Dattus Meter Technical Reference Guide Usage 
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Dattus Nomenclature 

This reference guide refers to the Dattus meter circuit boards responsible for a variety of 

functions. Dattus meter versions addressed in this guide have three circuit boards (the 

Dattus Basic-L is the exception and does not contain a DS1 board): 

 DM2. Metrology board 

 LC2. Primary display board 

 DS1. Corrector board 
 

DM2 Board (Metrology) 

DM2 refers to the Dattus second generation metrology. The DM2 board may be referred to 

as the meter since it is the component that receives the raw signal from the meter's sensors 

and processes the raw signal to accumulate uncorrected volume. The uncorrected volume 

pulse is fed to the LC2 or DS1 board depending on the meter configuration. A DM2 board 

on the Basic-L meter may also apply a correction factor to the volume if the meter is 

configured for fixed factor pressure correction (the pulse to the LC2 is a corrected pulse). 

The DM2 board also holds the data logging information and manages security and 

communications when interrogating the meter using the PCLink software. 
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LC2 Board (LCD display) 

The LC2 board is the main display on the Dattus. The LC2 displays the meter's volume 

information and indicates alarm and flow (if enabled). The LCD board continuously 

displays meter volume, manages the pulse outputs, and contains the RS-232 chip that allows 

pass-through communication to the DM2. All meters are equipped with an LC2 board.   

 
 

DS1 Board (Corrector) 

The DS1 board is the meter's corrector. Once the DM2 accumulates the uncorrected 

volumes, it re-transmits the uncorrected volume pulses to the DS1. Dependent of the meter 

configuration, the DS1 measures the temperature or pressure and calculates the correction 

factor. The DS1 board applies the correction factor to the uncorrected volume pulses from 

the DM2. Then, the DS1 increments the LC2 with the corrected volume and manages pulse 

outputs and display updates for the DS1 display. The display is a secondary LCD that is not 

normally energized and requires activation by the customer who either pushes the display 

button (standard) or waves a magnetic wand to activate the display. The DS1 is configurable 

and can display up to 16 different information types. 
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Features 

Dattus meters feature:  

 Static measurement technology 

 Gas volume totalizing 

 Live correction factors 

 Fixed pressure factor correction 

 Configurable pulse outputs 

 Meter capacities from 1000 to 56000 CFH 

 Field upgradeable capacity 

 Datalogging (optional) 

 Event logging 

 RS-232 communications 

 MODBUS protocol 
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Model Overview 

Dattus models offer variable features: 

 Basic-L. Basic-L meters function primarily as counters by simply recording the 

accumulated actual volume that passes through the meter without performing any type 

of correction. A fixed factor pressure correction option within PCLink can be applied 

to the gas measurement and displayed as corrected volume. 

 Basic-EXT. Basic extended (-EXT meters) function like the Basic-L but have an 

additional DS1 circuit board. There is no temperature or live pressure correction in the 

Basic-EXT meter. The primary purpose for the Basic-EXT meter is to provide DS1 

display information.  

 P-Only. P-Only Dattus meters are equipped with pressure transducers that allow the 

meter to compensate for pressure fluctuations. 

 ETC-L. ETC-L meters are equipped with temperature probes that allow the meter to 

compensate for temperature fluctuations. 

 PTZ-L. PTZ-L meters are equipped with both a temperature probe and a pressure 

transducer to correct for live temperature and pressure fluctuations. This meter is 

configurable for super-compressibility compensation (Z). 

 

  Basic-L Basic-EXT P-Only ETC-L PTZ-L 

Static measurement technology Yes Yes Yes Yes Yes 

Gas volume totalizing Yes Yes Yes Yes Yes 

Fixed factor correction Yes Yes No Yes No 

Configurable pulse outputs Yes Yes Yes Yes Yes 

Meter capacities from 1000 to 56000 CFH Yes Yes Yes Yes Yes 

Field upgrade capacity Yes Yes Yes Yes Yes 

Data logging Yes Yes Yes Yes Yes 

Event logging Yes Yes Yes Yes Yes 

RS-232 communications Yes Yes Yes Yes Yes 

MODBUS protocol Yes Yes Yes Yes Yes 

Live temperature correction No No No Yes Yes 

Live pressure correction No No Yes No Yes 

Configurable DS1 display No Yes Yes Yes Yes 
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General Specifications and Dimensions 
  fM2 fM3 

Minimum flow (±2%) 22CFH 60CFH 

Accuracy (±1%) 60 CFH to meter max 100 CFH to meter max 

Flange to flange 22 CFH to 60 CFH 60 CFH to meter max 

Flange size 2 inch or 3 inch ANSI 125 4 inch ANSI 125 

Shipping weight 42 pounds 128 pounds 

Operating temperature -40 to +140º F (-40 to +60º C) 

Maximum allowable operating 

pressure (MAOP) 

150 PSIG 175 PSIG 

Communication RS-232 and MODBUS  

Pulse outputs Four channels, three-user configurable. Configurable pulse 

weight and pulse width. For details, see pulse outputs.  

Power Supply Two D-cell lithium batteries at 3.6V 

Meter body and electronic housing enclosure 

Cast aluminum (AT356T6) 

External cover display ASA (acrylonitrile styrene acrylate) 

See Appendix A for details on sizing, capacity, turn-down, and pressure drop information. 

 

Dattus Meter Dimensions 

 

 

Dattus 
Model 

A B C D Thread 
Depth 

Flange Size 

fM2 16.5 in. 

(41.9 cm) 

10.6 in. 

(26.9 cm) 

6.75 in. 

(17.1 cm) 

10.0 in. 

(25.4 cm) 

1.0 in. 2 in. or 3 in. ANSI 125 Note: 

Spacer kit is available for 3" 

flange retrofit to 9.5 in. C 

dimension. 

fM3 23.7 in. 

(60.2 cm) 

16.5 in. 

(41.9 cm) 

9.5 in.  

(24.1 cm) 

15.2 in. 

(38.6 cm) 

1.0 in. 4 in. ANSI 125 
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Meter Components 

The Dattus meter is comprised of three main components: 

 Measurement unit 

 Electronics housing 

 External cover 
 

Measurement Unit 

The measurement unit is the only meter component exposed to gas. Threaded pressure taps 

provide access to the various internal gas chambers to monitor pressure.  

The measurement unit is an aluminum structure designed to ensure gas tightness up to line 

pressures of 150 psig (10 bar) for the FM2 models and 175 psig (12 bar) for the FM3 

models. 

 

A Pressure taps 

B Gas inlet 
 

Electronics Housing 

The electronics housing is a clear UV-stabilized polycarbonate that contains the DM2 

Metrology board, LC2 board LCD, and DS1 Corrector board (dependent on model).  The 

electronic housing is compliant to IP-67 and  NEMA-4 standards for water submersion and 

dust exposure. 
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Dattus Basic-L 

Dattus Basic-L meter face components are shown in the cover design below.  

 

Basic-L meter face components 

A Meter type 

B Meter descriptor 

C LCD display screen (LC2 board) 

D Pulse outputs connector 

E Serial number 

F Meter multiplier 

G Communication connector 
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Dattus Corrector Models 

Dattus Corrector models include: 

 PTZ-L 

 ETC-L 

 P-only 

 Basic EXT 

All Corrector models share the same meter face cover design shown below. 

 

Dattus Corrector meter  face components 

A DS1 display screen 

B LC2 display screen 

C Meter descriptor 

D Pulse connector 

E Push button 

F Meter type 

G Serial number 

H Meter multiplier 

I Communication connector 
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LC2 Liquid Crystal Display (LCD) 

 

Note  Dattus meter LCDs display uncorrected or fixed factor corrected volume. 

The LCD displays four to six digits. The number of digits displayed is listed on 

the Dattus meter label.  

The LC2 Display is configured using PCLink™ software to display (Imperial units) from 1 

cubic foot to 1000 cubic feet (CFx1 to CFx1000) or (Metric units) cubic meters (CMx1). 

The Dattus unit multiplier is noted on the meter face. Use the LCD readout multiplied by the 

unit multiplier to determine the register's total volume. Dattus meters provide an additional 

unit descriptor that is either uncorrected or corrected volume. The additional descriptor is 

dependent on the meter model. 

Uncorrected volume Indicates the volume on the register is not corrected on Basic-L models. The 

register represents the actual cubic feet (or cubic meters) volume. 

Corrected volume Indicates the volume is corrected for a known fixed pressure on Fixed Factor 

enabled Basic-L and DS1 models. Typically, there is a label on the meter 

indicating the fixed pressure programmed into the meter.  

 

Caution  Both the unit multiplier and the uncorrected or corrected volume are 
configurable using the PCLink software. If the unit multiplier and volume 
parameters do not match the printed unit multiplier, there may be a register 
misinterpretation.  

  

Dattus LCD display descriptions 

A Flow indicator. The flow indicator helps calculate the flow rate (clock the meter). 

Symbols move in proportion to flow and change at a rate of 1/10th of the unit 

multiplier. Flow indicator is enabled or disabled using PCLink software. (See flow 

rate.) Flow indicator is typically disabled on Dattus Corrector models since the DS1 

can display live flow rates.  

B Alarm indicator. The alarm indicator decimal points flash if the alarm is live. The 

decimal points flash if the alarm is saved. The alarm decimal point will flash on the 

LCD every 12 seconds (see Alarms for more information.) 

C Battery indicator. A flashing battery indicator signals a low battery alert (see 

Alarms or PCLink Software Basics for more information.) 
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DS1 Display 

 

Note  The Dattus DS1 display can show up to 16 types of information. The DS1 

display is configured using the PCLink software DS1 Display tab. 

 

DS1 Display information 

A Display item units. Display item unit type. 

B Display item. Description of the current item. 

C Display item value. Numeric value of current item displayed. 

D Alarm indicator. Live DS1 alarms (see ). 

E Display item number. Selected "display item" number on DS1 Display tab. 

 
 

Dattus Operating Principle 

Dattus fM meters operate on the fluidic oscillation principle based on Bernoulli's theory that 

states for an inviscid flow, an increase in the speed of the fluid occurs simultaneously with a 

decrease in pressure or a decrease in the fluid's potential energy.  

The Dattus meter creates slow moving high pressure gas which becomes a fast moving low 

pressure gas at the nozzle exit forming a jet of gas.  

Once formed, the gas jet can be controlled (by the Coanda effect) using an obstacle in the 

flow designed to optimize the meter's performance. The gas jet path is controlled to enable 

the formation of feedback pressure nodes on either side of the gas jet resulting in a 

predictable gas jet oscillation.  
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The Dattus meter metrology relates to the fluidic oscillation chamber's mechanical design 

and conditioning flow entry. Gas jet oscillations are detected using a thermal sensor device 

that provides metering data to the meter's electronic index. The measurement unit consists 

of three functional elements shown below: 

A Flow conditioner 

B Jet nozzle formation 

C Fluidic oscillation chamber 
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As shown in the following diagram, gas enters the meter (1) and divides into two separate 

flow paths (2). These two flows recombine (3) as they exit the flow entries and enter the 

fluidic oscillation chamber (5) through the nozzle. The process of dividing the flows 

eliminates upstream disturbances and creates a well-conditioned flow. In the fluidic 

oscillation chamber, a jet forms as the gas enters through the nozzle (4). Then, the gas starts 

oscillating back and forth (5). Thermal sensors located just after the nozzle (6) detect a 

temperature variance as the gas jet passes from one side to the other. The volume of gas 

passed through the meter is counted by the number of oscillations detected by the thermal 

sensors. The gas passes around the obstacle and exits the meter (7). 

 

Flow diagram 

1 Gas entry 

2 Flow paths 

3 Recombined flow 

4 Flow exit into fluidic oscillation chamber 

5 Fluidic oscillation chamber 

6  Gas exit 

7 Nozzle 

8 Conditioning flow chamber 

9 Fluidic oscillation chamber 

10  Thermal sensors 

11  Gas flow jet 

12  Obstacle    

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Chapter 1 Dattus Meter Technical Reference Guide Usage  

22 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


 

TDC-0853-001 Dattus Meter Technical Reference Guide  23 

 Proprietary and Confidential 
 

 

Warning  These instructions are suggested when Itron-approved utility or installer 
company-established meter installation procedures and practices are not available.  

Itron does not endorse or warrant the completeness or accuracy of any third party 
meter installation procedures or practices, unless otherwise provided in writing by 
Itron. Follow your company's standard operating procedures regarding the use of 
personal protection equipment (PPE). Adhere to guidelines issued by your company 
in addition to those given in this document when installing or repairing meters.  

 This product, as of the date of manufacture, is designed and tested to conform to all 
governmental and industry safety standards as they may apply to the manufacturer. 
The purchaser/user of this product must comply with all fire control, building codes, 
and other safety regulations governing the application, installation, operation, and 
general use of this meter to avoid leaking gas hazards resulting from improper 
installation, startup or use of this product. 

To ensure safe and efficient operation of this product, Itron strongly recommends 
installation by a qualified professional. 

 
 

Receiving Your Meter 

Handling and Storage 

Store the meter in a clean, dry environment until you are ready to install the meter. The 

meter ships with protection caps on the inlet and outlet sides to prevent foreign matter from 

entering the measurement unit (see the following diagram). The protection caps must remain 

in place until mounting the meter in the system. 

 

 
 

C H A P T E R  2  

Receiving and Installing the Dattus Meter 
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Unpacking and Inspection 

The meter is packaged in a well-supported cardboard box. If the box is damaged, notify the 

carrier immediately of a potential mishandling problem. 

The meters are packed individually. Each package should contain the following 

components: 

 Meter with protection caps on the inlet and outlet 

 Meter seals 

 Calibration certificate 

 Installation instructions 

 Control drawing 
 

Installation (Proper Meter Orientation) 

Horizontal Pipe Run 

Itron recommends installing the Dattus meter with the index (LCD) out to the side in 

horizontal pipe runs (meter's long axis is parallel to the ground) as in the figure below. 
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Vertical Pipe Run 

Itron recommends installing the Dattus meter with the gas flow down in vertical pipe runs as 

shown in the figure below. 

 

Incorrect Installation Example 

            

Warning  Incorrectly installed Dattus meters (installations with the index [LCD] facing 
up) increase the likelihood contaminants in the gas line can strike and damage the 
sensors used to measure gas flow. In rare cases where the gas line is free of 
contamination, the Dattus meter could be installed in any orientation. In most 
installations, there is some contamination (rust, sand, weld slag, pipe shavings or 
other foreign materials) in the gas line. Orienting the Dattus as recommended above, 
minimizes the chance of debris damaging the meter's sensors. Dattus meter sensors 
damaged by pipeline contaminants are not covered by the meter's warranty. 

 

Incorrect installation 

 

Note  Itron recommends using a strainer or filter device upstream of the 

meter.  This protects the meter as well as all downstream equipment. 

 

Warning  If liquids are present in the metering line, Itron recommends 
mounting the meter in a horizontal position and/or the use of a filter 
designed to remove liquids from the metering line. 
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Rotating the LCD 

If the Dattus LCD readout is configured from the factory (or your Itron distributor) 

incorrectly for your installation (for example, the LCD is oriented for a left to right gas 

flow, horizontal application and you would like it for a vertical application (see Vertical 

Pipe Run on page 25), it may be modified using the following process and images.     

 

 

 Remove the meter cover. 

 Rotate the electronics housing. 

 Re-install the meter cover. 
 

Start-up/Shut-down Procedures 

Meter start-up and shut-down procedures depend on the installation type. This section 

includes installation procedures with and without a by-pass. 
 

Installing the Meter 

When installing the meter: 

 Verify the meter is oriented correctly for installation. 

 Remove the protective caps from the meter inlet and outlet. 

 Install the meter using the appropriate 5/8-inch bolts. 

 Tighten the bolts in a cross pattern with 55-60 ft/lbs of torque. 

 

Warning  Always open and close valves slowly to prevent pressure surges 
that may damage equipment. 
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Installation with a By-Pass 

The following diagram shows an example of an installation with a by-pass: 

 

 
 

To shut down the meter (with bypass) 

1. Slowly open the by-pass valve (V4). 

2. Close the inlet valve (V1) of the metering line. 

3. Close the outlet valve (V2). 

4. De-pressurize the metering line (not exceeding 4 psi per second) with the small bleed 

valve (V3). 
 

To start up the meter (with bypass) 

1. Slowly open the outlet valve (V2) to pressurize the metering line (not exceeding 4 psi 

per second). 

2. When the metering line is completely pressurized, fully open the outlet valve (V2). 

3. Check for leaks by applying soapy water to the joints and looking for air bubbles. 

4. Open the inlet valve (V1).  

5. Close by-pass valve (V4). 

6. Verify the flow does not exceed the capacity of the meter. 
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Installation without a By-Pass 

The following diagram shows an example of an installation without a by-pass: 

 

 
 

To shut down the meter (without bypass) 

1. Slowly close the outlet valve (V2). 

2. Close the inlet valve (V1). 

3. Open the bleed valve (V3) and slowly de-pressurize the metering line (not exceeding 4 

psi per second). 
 

To start up the meter (without bypass) 

1. Slowly open the inlet valve (V1) to pressurize the metering line (not exceeding 4 psi 

per second). 

2. Open the outlet valve (V2) until the outlet pressure is stable. 

3. Check for leaks by applying soapy water to the joints and looking for air bubbles. 

4. Fully open the outlet valve (V2). 

5. Check that the flow does not exceed the capacity of the meter. 
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Chapters 3, 4, and 5 provide the information for interrogating and programming the Dattus 

meter. These chapters provide Dattus information most often requested by meter users and 

support sections in this guide that reference PCLink. 
 

PCLink Topics 

Chapter three provides the following PCLink information. 

 System Requirements 

 Installing PCLink 

 Setting up communication ports 

 Verifying communication ports 

 Logging on to the Dattus meter 

Chapters four and five provide additional PCLink information for: 

 Calibration 

 Alarms Status 

 Alarm options 

 Pulse outputs 

 Upgrading 
 

System Requirements 

Compatible Operating Systems 
 Windows® NT4 with service pack 4 

 Windows 2000 Professional with service pack 4 

 Windows XP Professional edition with service pack 2 

 Windows Vista 

C H A P T E R  3  

PC Link Software 
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Recommended Minimum Hardware Requirements 

 Processor.  Intel or AMD with at least 300 MHz 

 RAM.  128 Mbytes 

 Graphics.  SVGA 1024x728 - 256 color 

 Hard Drive. PCLink occupies about 36MB, additional hard drive space may be 

required dependent on file management needs and PCLink upgrades 

 CD ROM.  CD for installation (or alternative) 

 Output Connection Port.  Either a direct serial port connection or USB (for use with 

USB to serial port converter/adapter). 

 Communication cable.  Part Number 600204-001 
 

Installing PCLink 

PCLink software basic installation is similar to other software installations.  If you received 

a software CD from the factory, it is configured as AutoPlay and begins the installation 

process when the CD is inserted in the drive. 

If PCLink installer does not automatically begin installation, navigate through Windows 

Explorer to the CD-ROM drive and double-click the PCLink_Setup.exe file.  

After the splash screen displays, a series of screens (beginning with Start, then Installation 

Agreement, Registration, and Installation Type) display where you configure your desired 

installation.  
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Installation Type 

PCLink gives you the option to either install the full version or install a custom installation 

(see the Installation Type Selection figure below). Itron recommends a full installation.  

Installing a PCLink customized version would save about 3MB of hard drive space and 

would remove the useful Online Help File and Templates. 

 

 

Note  There are options for selecting alternative file locations and folder names.  

Itron recommends keeping the selected defaults to make support easier to 

provide if necessary. 
 

Setting Up or Verifying Communication Ports 

Once PCLink successfully installs, setup the proper communication ports to successfully 

communicate with a Dattus meter.  You will need both the physical connections between the 

computer and the Dattus and the communication ports between Windows and PCLink 

properly configured. 
 

Hardware 

Communication with the Dattus meter requires a communications cable (600204-001) 

available from your Itron representative. The communications cable has a Binder 

connection (type of connector on the Dattus meter) on one end and a DB9 serial Port 

connection on the other end. 

Connection to your laptop/desktop requires either a direct serial port connection (DB9) or 

connection using a USB to serial port converter (adapter). Properly install the drivers for the 

USB converter. 

 

Note  A PCMCIA card may be used instead of a direct serial port connection or 

USB converter. PCMCIA cards are generally more expensive and less support 

experience is available for those using PCMCIA cards with Dattus meters. 
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Software Configuration 

If you are using a direct serial port connection on the back of your computer, it is typically a 

COM1 port by default and you may skip this section (unless you experience difficulties 

connecting to the Dattus meter).  

To determine which COM Port Windows assigned for the USB adapter 

1. Navigate to My Computer (typically available as an icon on the desktop as shown 

below).   

 

2. Right-click the My Computer icon to display the menu shown below. 
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3. Select Properties.  This will populate your System Properties dialog (shown below). 

Properties are also available by going to the control panel and selecting System.  

Select the Hardware tab. 

 

 

4. On the Hardware tab, click the Device Manager button. 
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5. The Device Manager provides access to view how Windows assigned the COM port 

selections (see the figure below). This is available under the Ports (COM & LPT) 

selection in Device Manager. 

 

In the above example, the user has both a direct port (assigned to COM1) and a  

USB-to-Serial Comm Port (COM4). Note the COM Port number so you can match the 

COM selection in PCLink. 
 

Logging On to the Dattus Meter 

After successfully installing PCLink and identifying the COM Port, verify the same COM 

Port is also configured to match in PCLink. COM1 is the default. 
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To select the COM port in PCLink 

1. Start the PCLink software application. The opening screen shown below displays. 

 

2. Open PCLink's software preferences by doing one of the following: 

 Click the Preferences (Prefs) icon. 

 Select File > Preferences 

 Press CTRL+P.  

2. The Software Options dialog displays. 

 

3. Click the Comm Port drop-down and select the COM Port that matches the COM 

Port configured in Device Manager. After you make your selection, click Apply. 
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To test PCLink communications 

1. Select Communications > Test Connection, or press F2. A successful connection 

test displays a message box indicating that the connection is successful. 

 

2. Click OK to close the message box. 
 

To Logon 

1. To Logon, do one of the following: 

 Click the Log On icon. 

 Select Communications > Log On. 

 Press F3. 

2.   A password box displays.   

 

3. Enter your password, and then click Log On. 
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Default Passwords 

PCLink default passwords provide for initial logon to PCLink software.  

 

PCLink Default Passwords 

Password Description 

11111 Read-Only Access. This password allows the user to log onto the meter and download any 

available data. Programming capability is disabled. Also called Operator Access. 

22222 General Access. This password allows all PCLink read and write privileges available to a 

customer.  Also called Supervisor Access. 

 

 

Notes  Supervisor Access limitations are dependent on governmental regulatory 

requirements.  For example, in Canada, a user may only overwrite metrological 

parameters if the measurement seal is broken and a programming switch is 

enabled. 

Users with Supervisor Access may change passwords when they use PCLink 

software.  This function is not covered in this technical reference guide. 

PCLink software is backwards compatible.  The newest version of PCLink will 

work with any previously sold Dattus meter.  Itron, Inc. will periodically release 

new operating system (firmware) versions for the Dattus meter. New firmware 

releases may create new features, improve an existing feature, accommodate a 

design change, or fix a problem.  Sometimes these newer firmware versions 

will require a newer PCLink version.  Dattus meters are programmed to not 

allow  non-compatible PCLink software to communicate with the meter and 

will display a message box stating a newer PCLink version is required. 
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PCLink File Types 

Save PCLink software and functions in one of four file formats. The format is dependent on 

the information being saved.  

 PCL. The PCL file saves the configuration tabs downloaded during the logon session. 

This file is essentially a snapshot of the meter's configuration setup. 

 PCA. A PCL file is a saved snapshot of a downloaded data log. Only the informational 

tabs downloaded in the logger (hourly, daily, monthly) will appear in the saved file.  

You can export the information contained in the PCA to Microsoft Excel. 

 PCE. The PCE file is a snapshot of the event logger. You can export the information 

in this file to Microsoft Excel. 

 PCK. PCK files are used only to perform meter upgrade changes.  
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Communications to the Dattus meter using PCLink is done primarily through navigational 

tabs or configuration pages. This chapter covers the available configurations generally 

accessed by typical users. 

 

Note  PCLink has associated language files (not covered in this manual) that 

are used for all descriptions used in PCLink. This language file is modified 

from time to time to improve the descriptions for various PCLink functions 

and to make the software most usable to the broadest base of PCLink users. 

Occasionally,  menu items or descriptions may be different than they are 

described in this manual.  The location and availability of these menus and 

functions are not affected by this file, only the description.  Periodic updates 

to this manual will be made to reflect any changes.   

PCLink software design provides navigation similar to other Windows applications.  All 

user-accessible functions and configuration tabs are accessed by either using the Modbus 

Parameters menu options, or by right-clicking in the gray area to access the same menu as 

shown below.  As tabs download, they populate the bottom of the screen. 

 

 

 

 

The Associate button acts as a toggle switch between the meter side and corrector side of 

the meter.  

 

C H A P T E R  4  

Basic Navigation 
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(1/2) denotes the meter side;  

 

(2/2) denotes the corrector side. 

 

 

Note  The Associate button applies only to Corrector model meters (PTZ-L, 

ETC-L, P-Only, and Basic-Ext).  

Some configurations may be shaded (grayed) out. These options are either not available for 

the meter type you logged onto, or the feature is not enabled for your meter. 

 
 

Program/Refresh Function 

When you first log on and download configuration data from the meter, the software user 

interface (GUI) populates with the programmed meter configuration (and current 

information).  Any changes made to the GUI are not made to the meter until you click 

Program as described below. 

 

Refresh. Clicking this button downloads the current configuration and information from the 

meter into the GUI. 

 

Program. Clicking this button programs any changes made in the GUI to the meter.  Make 

sure that your changes are accurate before clicking this button. 
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This chapter briefly outlines and describes PCLink tabs. 

 

Note  At initial log on to the Dattus meter, the first screen that displays is the 

Device Info tab. You may download all accessible meter configurations by 

pressing F5, or selecting Communication > Download all Tabs, or enabling 

an automatic download on log on by selecting Auto Download Data in 

Preferences. 
 

Device Information Tab 

 

Note  When you initially log on to the Dattus meter, the first screen displayed 

is the Device Info tab.  You may download all of the accessible meter 

configurations either by pressing F5, by selecting Communication > 

Download all Tabs, or by enabling an automatic download upon log on by 

selecting Auto Download Data in Preferences. 

The Device Info tab displays when you log on to a Dattus meter with PCLink. This 

configuration tab defines the meter's major attributes. The Utility Serial Number, 

Customer Name, and Site Identifier fields are user-configurable fields.  All remaining 

fields are factory-defined. 

 

 

C H A P T E R  5  

Configuration Tabs 
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The following table describes each of the Device Info tab fields.  Some of these items may 

be modified with an Upgrade (see Upgrading a Dattus Meter). 

 

Field Description 

Meter Identification 

Utility Serial Number The unique utility ID. 

Manufacturer's Serial 

Number 

The unique factory ID for the meter.  This number is required to create keys 

for upgrades or for technical support. 

Manufacturing Date/Time The date and time of the meter's manufacture. 

Firmware Revision The firmware (both DM2 and DS1) supplies the operating instructions for the 

meter. (The software supplies the application that runs the meter. This 

distinction may be important if technical assistance is required.) 

Firmware Date The firmware revision's release date. 

Site Information 

Customer Name Customer's name. 

Site Identifier An identifier for this site (i.e., address). 

Dattus Model and Size 

 Meter model (FM2 or FM3) and capacity listed in industry nomenclature 

(1M, 1.5M…56M).   

 Physical flange connection size (2", 3", or 4"). 

Factory Configuration and Device Status 

# of Meter Restarts Indicates when the meter reboots itself.  This can be caused by  

disconnection/re-connection of the batteries. 

Last Restart Occurred Indicates the last meter restart date and time. 

Days Left on Batteries An estimated countdown of the number of days left in the batteries. This field 

is dependent on the meter's initial configuration and number of days in use. 

Program Enabled If checked,  

Options 

Metric Enabled If checked, Metric is used for all volume (m3), pressure (bar), and temperature 

(Celsius) measurements/configurations.  If unchecked volume is in CF, 

pressure in PSI, and temperature is in Fahrenheit. 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


 Fixed Factor Tab (LC2 Display Tab)  

TDC-0853-001 Dattus Meter Technical Reference Guide  43 

 Proprietary and Confidential 
 

Field Description 

Secure Data Overwrite  A security provision not currently used. 

Data logging Enable If checked, the meter is configured to log data (create an audit trail).  If 

unchecked, this feature is not accessible. 

DST for US Enable If checked, the meter accommodates Daylight Saving Time (U.S. standard) in 

its clock. 

Meter Configuration Meter definition (Basic-L, PTZ-L, P-only, ETC-L). 

Region Setting Security configuration setting. Choose between North America and Canada.  

North America allows full users read and write access (user must provide 

proper password). Canada has certain restrictions due to meter sealing 

requirements. 

 
 

Fixed Factor Tab (LC2 Display Tab) 

The LC2 Display tab controls the LCD Readout configuration and pressure configuration 

when Display Corrected Volume is selected. (The LC2 Display tab may also be called 

Always on LCD.)   

The LC2 Display tab is shown in following screen with Display Corrected Volume 

selected. 
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The following table describes the LC2 Display tab fields. See LCD Display on page 107 for 

an LCD visual.  

Field Description 

Display Configuration 

# displayed digits The number of digits shown on the LCD. User configurable from 4 to 6 digits. 

Flow Indicator If checked, allows meter clocking. 

Show Sync If enabled, Show Sync will momentarily display SYNC on the LCD and 

allow it to be an alarm condition if communication is broken.  See Alarms for 

more details. Itron recommends keeping this enabled. 

Display Corrected Volume If enabled, will display the Fixed Factor parameters. (Fixed factor parameters 

are described in the next table). 

Display Volume 

Selected Units  Configures the LCD units, typically CFx100 or CFx1000. 

Check the Display Corrected Volume box to enable fixed factor pressure correction. After 

you enable fixed factor pressure correction (check Display Corrected Volume), the Fixed 

factor parameters box displays on the LC2 Display tab (see the following LC2 Display 

screen). 
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Selecting Display Corrected Volume changes the LCD's register display and allows you to 

configure Fixed factor parameters  (see Meter Volumes (Volumes Tab) on page 47) for 

the descriptions of volume registers). The following table describes the Fixed factor 

parameters fields.  

Field Description 

Fixed Pressure The pressure that will go through the meter.  Pressure must be very stable to 

ensure correction factor  accuracy. 

Atm Pressure Atmospheric Pressure.  The local atmospheric pressure or the standard 

atmospheric pressure used to calculate the correction factor. 

Base Pressure The contract pressure, also called billing base. 

Correction Factor The factor (multiplier) applied to the uncorrected volume to obtain the 

corrected volume.  The factor is calculated by adding the Atmospheric 

Pressure and the Fixed Pressure and dividing that value by the Base Pressure.  

This box shows the result of the calculation. 

Corrected Pulse Weight The Dattus meter calculates fixed factor by applying the correction factor to 

the oscillation pulse weight to get the Corrected Pulse Weight.  Each 

oscillation at this oscillation pulse weight is counted in the Corrected Volume 

Register.  See the caution below on Calc vs. Saved values. 

   Caution  When modifying Fixed factor parameters, ensure all  

    parameters are correct before they are programmed into the meter.  

   The following validation check may be performed:  

   The Calc Corrected Pulse Weight is the correction factor multiplied 

    by the oscillation pulse weight in the software. The Saved  

    Corrected Pulse Weight is the value programmed into the meter.   

    After programming new values, click refresh and verify the Calc and 

    Saved values match.  

    Because part of the LCD Configuration is printed on the label (see  

    LCD Display (Readout), changing the configuration programmed  

    into the meter may lead to a mismatch between the programmed  

    configuration and that listed on the display. 

 

 

Note  When buying a pre-configured Dattus meter from the factory, the Atm 

Pressure will be programmed for 14.4 PSI and the Base Pressure will be 14.65 

PSI unless otherwise specified. 
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Meter Database Tab 

The Meter Database tab allows configuration for meter data logging. 

 

The following Meter Database tab table describes the Database tab fields. 

Field Description 

Database Options 

Enable Hourly Logging If enabled, select the number of days to log hourly data. 

Enable Daily Logging If enabled, select the number of months to log daily data. 

Gas day start hour Select the time of day to begin logs. 

Enable Monthly Logging If enabled, select the number of years to log monthly data. 

Configurable Interval Logger 

Enable Logger If selected, Enable Logger allows you to configure the data logging intervals.  

Interval If Enable logger is selected, configure the time interval to perform data logging. 

Range is 30 seconds to 30 minutes. 

# of records If Enable Logger is selected, configure the number of records. The number of 

available records for all Basic meters is 3100. For all other meter types, the 

number is 1800. 

Selectable Items to Log 

Choose the battery voltages  
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Meter Volumes (Volumes Tab) 

The Meter Volumes tab includes register volumes (Uncorrected and Corrected), user 

configured overflow, and meter maximum flow rate as shown in the following figure.   
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The table below describes of each of the Volume Tab fields.  

Field Description 

Uncorrected Volume Register 

Uncorrected Volume 

(Integer) 

The integer volume for the Dattus meter uncorrected volume.  Units are CF or 

m3 dependent on configuration. 

Volume under alarm Only increments if selected as an option in Alarm Options and the  meter is in 

an alarm condition.  Generally not used. 

High Resolution Volume Includes the integer volume plus the fractional increment volume. 

Corrected Volume (Fixed Factor Pressure) 

Volume The volume register that increments the register at the Corrected Pulse Weight 

described in the LC2 Display tab   if Display Corrected Volume is enabled. 

If the Display Correct Volume is not enabled on the LC2 Display tab, the 

Uncorrected Volume is displayed. 

User Max Flow Rate 

Before Alarm 

This is a user-configurable field for the maximum flow rate before alarm.  It 

also configures the scale for the High Frequency pulse output, discussed in 

Output Modes. 

Maximum Flow Rate - Uncorrected 

Max flow rate  This is the maximum flow rate the meter has seen since its last reset.  See 

Resetting Alarms via PCLink. 

Pulse Output Residuals 

Output #1 

Output #2 

Output #3 

Output #4 

Records the volume for each pulse output residual register.  When the volume 

reaches the pulse weight configured for that output, it closes an electronic 

switch and resets the residual volume to zero. When zeroing a meter, pulse 

output residual should also be reset. 

Reset Values are valid at no flow only. 
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Input Config Tab 

The Input Config tab allows you to monitor and implement power saving Dattus meter 

features. 

 

The following table describes the Input Config tab fields. 

Field Description 

Corrector Wakeup Schedule 

Time Based Wakeup Wakes the DS1 at the configured time and applies new correction 

factors to the uncorrected volume. 

Volume Based Wakeup Wakes the DS1 at the configured volume and applies new correction 

factors to the uncorrected volume. 

LCD Auto Timeout 

Timeout for power saving  

(display OFF) 

Powers down the DS1 LCD at the configured time. 

Uncorrected Input Volume 

Input Pulse Volume The corrector's index drive rate. 

Active Correction Factors 

Temperature Factor (CT) 

The current live and/or fixed correction values. 
Pressure Factor (CP) 

Compressibility Factor (CZ) 

Correction Factor = CT*CP*CZ 
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Database Config Tab (DS1) 

The Database Config tab allows you to configure the Dattus meter's logged data database. 

 

The following table describes the Database Config tab fields. 

Field Description 

Database Options 

Enable Hourly Logging If enabled, select the number of days to log hourly data. 

Enable Daily Logging If enabled, select the number of months to log daily data. 

Gas day start hour Select the time of day to begin logs. 

Enable Monthly Logging If enabled, select the number of years to log monthly data. 

Configurable Interval Logger 

Enable Logger If selected, Enable Logger allows you to configure the data logging 

intervals.  

Interval If Enable logger is selected, configure the time interval to perform data 

logging. Range is 30 seconds to 30 minutes. 

# of records If Enable Logger is selected, configure the number of records. The 

number of available records for all Basic meters is 3100. For all other 

meter types, the number is 1800. 

Select Items for Logging 

Select the data items to display. The DS1 can display up to 16 items. 
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DS1 Display Tab 

The DS1 Display tab allows you to configure the items displayed on the DS1 LCD. 

 

The following table describes DS1 Display tab fields. 

Field Description 

Selected Display Items 

Select up to 16 items to view on the DS1 display.  

Display Units  

Temperature If Display Units is selected, configure the temperature designator. 

Pressure If Display Units is selected, configure the pressure designator. 

Uncorrected Volume If Display Units is selected, configure the uncorrected volume designator. 

Uncorrected Flow Rate If Display Units is selected, configure the uncorrected flow rate designator. 

Corrected Flow Rate If Display Units is selected, configure the corrected flow rate designator. 

# of decimal point displayed 

Temperature 
If  # of decimal points displayed is selected, configure the number of digits 

displayed after the decimal point. 
Pressure 

Correction Factor 
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Database Config Tab (DS1) 

The Database Config tab allows you to configure the Dattus meter's database of logged 

data. 

 

The following table describes the Database Config tab fields. 

Field Description 

Database Options 

Enable Hourly Logging If enabled, select the number of days to log hourly data. 

Enable Daily Logging If enabled, select the number of months to log daily data. 

Gas day start hour Select the time of day to begin logs. 

Enable Monthly Logging If enabled, select the number of years to log monthly data. 

Configurable Interval Logger 

Enable Logger If selected, Enable Logger allows you to configure the data logging 

intervals.  

Interval If Enable logger is selected, configure the time interval to perform data 

logging. Range is 30 seconds to 30 minutes. 

# of records If Enable Logger is selected, configure the number of records. The 

number of available records for all Basic meters is 3100. For all other 

meter types, the number is 1800. 

Select Items for Logging 

Select the data items to display. The DS1 can display up to 16 items. 
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DS1 Display Tab 

The DS1 Display tab allows you to configure the items displayed on the DS1 LCD. 

 

The following table describes DS1 Display tab fields. 

Field Description 

Selected Display Items 

Select up to 16 items to view on the DS1 display.  

Display Units  

Temperature If Display Units is selected, configure the temperature designator. 

Pressure If Display Units is selected, configure the pressure designator. 

Uncorrected Volume If Display Units is selected, configure the uncorrected volume designator. 

Uncorrected Flow Rate If Display Units is selected, configure the uncorrected flow rate designator. 

Corrected Flow Rate If Display Units is selected, configure the corrected flow rate designator. 

# of decimal points displayed 

Temperature 
If # of decimal points displayed is selected, configure the number of digits 

displayed after the decimal point. 
Pressure 

Correction Factor 
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DS1 Volumes Tab 

The DS1 Volumes tab displays current meter register volumes. 

 

The following table describes DS1 Volumes tab fields. 

Field Description 

DS1 Volume Registers 

Uncorrected volume The integer volume for the Dattus meter uncorrected volume. Units are CF 

or m3, dependent on configuration. 

High Resolution Uncorrected 

volume 

The integer volume plus the fractional increment volume. 

Corrected volume The raw uncorrected volume coming from the meter. The Corrected 

volume is multiplied by the correction factor found on the Input Config tab 

on page 49. 

High Resolution Corrected 

volume 

The sum of the integer corrected volume and the fractional increment 

volume. 
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Field Description 

User Config Alarm and Output Thresholds 

Uncorrected flow rate Rate calculation of the meter's (DM2) raw gas volume to corrector (DS1) 

with no correction. The calculation is completed based on eight input 

volume pulses from the meter to the corrector.  

Corrected flow rate The uncorrected flow rate multiplied by the DS1 correction factor found on 

the Input Config Tab on page 49. 

Pulse-output Residuals 

Residuals for outputs 1 through 4. 

Reset  

Recorded Flow Rates 

Current U flow rate Current uncorrected flow rate. 

Current C flow rate Current corrected flow rate. 

Max U flow rate Maximum uncorrected flow rate recorded by the meter. 

Max C flow rate Maximum corrected flow rate recorded by the meter. 
 

Records Tab 

The Records tab displays the average, minimum, and maximum flow rates, temperatures, 

and pressures from meter and displays them in hourly, daily, or monthly increments. 

Essentially the Records Tab acts as a smaller scale data log. 
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The following table describes the Records tab fields. 

Field Description 

Hourly, Daily, and Monthly records 

Snapshot begins at  

and stops at 

Displays the current and previous hourly, daily, or monthly time span for 

displayed records. 

Average U-flow rate Displays the average uncorrected flow rate for the current and previously 

selected time span. 

Unc Max Flow Rate Displays the uncorrected maximum flow rate for the current and 

previously selected time span. 

Average C-flow rate Displays the average corrected flow rate for the current and previously 

selected time span. 

Cor Max Flow Rate Displays the corrected maximum flow rate for the current and previously 

selected time span. 

Average temperature 

Min Temperature 

Max Temperature 

Displays the average temperature, average minimum temperature, and 

average maximum temperature for the current and previously selected 

time span. 

Average pressure 

Min Pressure 

Max Pressure 

Displays the average pressure, average minimum pressure, and average 

maximum pressure for the current and previously selected time span. 
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Temperature Tab 

The Temperature tab allows you to view Dattus meter temperature parameters. 

 

The following table describes Temperature tab fields. 

Field Description 

Temperature (RTD) Coefficients 

T=Ar^2+Br+C If selected, displays factory configured temperature coefficients. 

Current Temperature Reading 

Live If selected, displays the current temperature reading in the units chosen on the DS1 

Display Tab on page 51. 

User Programmed Temperature Thresholds 

If selected, displays the minimum and maximum user-defined minimum and maximum temperature limits. 

Recorded Temperature Range 

If selected, displays the minimum and maximum user-defined minimum and maximum temperature range. 
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Pressure Tab 

The Pressure tab displays the Dattus meter's pressure parameters. 

 

The following table describes the Pressure tab fields. 

Field Description 

Pressure Transducer Coefficients 

Displays factory-configured pressure transducer coefficients.  

User Programmed Thresholds 

Displays the user-configurable minimum and maximum pressure range the meter must operate within to prevent 

a prevent a pressure alarm (in Psi). 

Recorded Pressure Range 

Displays the minimum and maximum recorded pressure values (in Psi). 

Current Pressure Reading 

Displays the current pressure reading (in Psi). 

Pressure transducer 

serial number 

Displays the Dattus meter's transducer serial number. 
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PTZ Config Tab 

The PTZ Config tab allows you to select fixed factor or live measurement settings. Unlike 

Basic-L models, the fixed factor correction adjustments for meters equipped with a DS1 are 

made on the PTZ Config Tab.  

 

The following table describes the PTZ Config tab fields. 

Field Description 

Correction Settings 

Temperature, Pressure, and 

Compressibility Correction 

If selected, allows you to select between liver or fixed correction settings.  

Fixed settings are based on the parameters displayed on this tab. 

Fixed (or Backup) Correction Factors 

Temperature 

Settings implemented during fix factor measurement or alarm. Pressure 

Super X 

Temperature Parameters 

Fixed Temp 
Controls configurable fixed temperature parameters. 

Base Temp 
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Pressure Parameters 

Absolute 

Gauge 
Select parameter type. 

Fixed 

Controls configurable fixed pressure parameters (in Psi). Absolute 

Base 

AGA 8 Parameters 

Heat Value 

Displays current AGA 8 parameters. Values are acquired by manual input or 

by the generated AGA 8 table. 

Relative Density 

Mole fraction N2 

Mole fraction CO2 

AGA Gross Characterization  
 

AGA8 Table 

The AGA8 table is used to determine the compressibility factor. The compressibility factor 

is not a live calculation; it is polled from the AGA 8 table.  
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To generate the AGA8 table 

1. Select Tools > AGA8 calculation > Table. 

 

2. Enter the AGA8 parameters and select the calculation method. 

 

Note  There are two options for calculating the AGA8 table; Method 1 and Method 2. 

Method 1 requires the carbon dioxide mole fraction, the heating value, and gas's 

specific gravity. Method 2 requires the gas's specific gravity, carbon dioxide mole 

fraction, and nitrogen mole fraction. 

3. Click the Calculate button to write the values to the AGA8 table.  

Caution  Values are accepted only if the calculate function completes without failing. 

A failure is noted by a value of Error appearing in the AGA8 table. 

4. Click the Write config button to program the eight parameters.  

5. Click the Write table button to generate the AGA8 table based on the eight 

programmed values. 

Note  After a table is generated, it can be viewed again by opening the AGA8 table 

and clicking Read Config followed by Read table. 
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This chapter describes meter data extraction methods. 
 

Data Logger 

The Data Logger collects meter information on an hourly, daily, and monthly basis. It is 

primarily used as an audit trail for gas usage. The Data Logger is not a standard feature of 

the meter. 
 

To download the Data Logger 

1. Install and open the PCLink program.  

2. Click the desktop PCLink icon or press F3 to log on. Log on requires a user password.  

3. Select > Modbus Parameters > Data Logger. 

 

4. The Data Logger appears as a blank white screen. The meter configuration must be 

read from the meter to populate the Data Logger. Select Tools > Read meter config 

or click the Read Meter Config button. 

       

 

C H A P T E R  6  

Collecting Meter Information 
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5. After the meter is read, the Refresh Current Tab activates.  

 

The event logger has four selectable tabs (Hourly, Monthly, Daily, and 

Configurable). 

 

6. Select the desired event logger tab and click Refresh Current Tab to view the tab's 

content. 
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To save and export Data Logger information 

1. To save the Data Logger to a .pca file, select File > Save.  

 

2. The Data Logger can be exported to a Microsoft Excel® spreadsheet. Select Tools > 

Export to Excel. 

 

3. The Data Logger opens in Excel. 

 
 

Exporting Meter Configuration PCL Files to Microsoft Word 

Dattus meter configuration information can be downloaded and viewed in a two-page 

Microsoft Word® document. 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Chapter 6 Collecting Meter Information  

66 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

To save and view Dattus meter configuration information in MS Office 

1. Log on to the Dattus meter.  

2. Select Files > Transfer to MS Office > Save DOC file or Save XLS file. 

 

3. Name the file. MS Word files save as .doc files. MS Excel files save as .xls files. 

 

4. Open the saved meter configuration information file as an MS Word document or MS 

Excel spreadsheet. 
 

Event Logger 

The Event Logger records configuration changes and alarm occurrences for the currently 

logged meter. 
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To open the Event Logger and export the meter event log 

1. Select Modbus Parameters > Event Logger. 

 

2. The Event Logger opens as a blank screen. Press F3 to download the event log. 

 

3. Select Tools > Export to Excel (or press F8) to export the event log to an MS Excel 

spreadsheet.  
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This chapter provides the information to prove and calibrate the Dattus meter and verify 

meter accuracy.   

Proving a meter is comparing a reference volume (prover) with the volume measured by a 

meter under test. One system (prover) gets pressure inputs, temperature, and uncorrected 

meter volume from the meter under test. The prover system compares those values to the 

corrected volume measured by the prover (after accounting for pressure, temperature, and 

uncorrected volume differences between the meter under test and the reference). 

The proving procedure shown in the following information works with rotary transfer 

meters, specifically the Roots Model 5® transfer prover. Most prover technologies and types 

may be adapted for the Dattus meter.   
 

Materials List 

Proving the Dattus meter using the Model 5 Rotary Transfer Prover requires the following 

materials: 

 Dattus Meter 

 Rotary Transfer Prover and software 

 Rotary Transfer Prover hoses for pressure and temperature 

 25-feet proving hose or longest available proving hose 

 3-feet  proving hose (available from Itron) 

 Dampener  (Either Itron version or Roots version) 

 Choke Valve (available from Itron) 

 Inlet Conditioning Flange (for 2-inch FM2 model) 

 ¼-inchAllen Wrench  

 Dattus RS-232 communications cable (P/N 600204-001) 

 Dattus proving cable (P/N 442405-003)  
 

C H A P T E R  7  

Proving and Calibrating the Dattus Meter 
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Physical Setup 

The following information describes setting up the Dattus meter for proving. 
 

Using the Dampener Kit to Minimize Pulsation 

Rotating rotary pistons create pulsations in the gas stream. The effective gas flow opening 

and closing causes the pulsation. This effect is known to skew the measured accuracy of 

turbine meters using a rotary transfer prover. Utilities testing turbine meters with rotary 

transfer provers typically use dampeners to remove some pulsation effect and obtain a more 

accurate test result. Dattus meters require the use of a dampener for testing. 

The pulsation effect on Dattus accuracy is most pronounced between 500 CFH and 3000 

CFH. Above 5000 CFH, the effect is minimized enough that dampening is not required. 

This has been determined empirically and is specific to the use of the 10M rotary and the 

FM2 Dattus models.  

In addition to the dampener, the dampener kit also includes a plastic 2-inch flange and pipe 

assembly. This inlet conditioning is necessary to help remove additional bias when testing a 

2 inch flanged Dattus FM2 meter.  
 

Dampener Kit Setup 

Set up the Itron dampener kit following the figure below. 

 

 

A To Dattus meter 

B Choke valve 

C Dampener 

D 3-foot hose 

E To Prover 

 

Warning  Do not use the dampener as a pressure vessel. 
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Inlet Conditioning 

Testing a 2-inch Dattus FM2 requires a flange/pipe assembly as shown in the following 

figure. 

 

 
 

Model 5 Junction Box 

Model 5 junction box connections required for a Dattus meter are: 

 The Inlet Pressure Connection 

 The Temperature Probe 
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 The IO Pulser 

 

The outlet pressure connection is used to determine the differential across the meter.  This is 

only relevant to rotary meters and is not used in the accuracy calculation. 
 

Pressure and Temperature Connections 

The following figure shows pressure and temperature connections to the Dattus meter. 

Verify the flow direction is correct. The meter inlet is marked both on the meter casting and 

on the manufacturers' badge. 

 

A Inlet pressure connection 

B Temperature connection 

C To choke valve 
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Warning  The inlet pressure connection must be at the center 
pipe plug on the Dattus meter. The inlet pressure is the pressure 
used for correction in the prover. The pressure at the center pipe 
plug is the actual pressure at the measurement point for the 
Dattus meter. 

 

Proving Cable Connection 

The Proving Cable connection goes directly from the Pulse Outputs Connection (see Dattus 

Basic-L on page 16) into the Model 5 junction box. After the physical setup is completed 

between the Dattus meter and the Model 5 Junction Box, the software configuration for both 

the meter and the junction box need to match as described in Software Configuration Setup. 
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Software Configuration Setup 

This section describes PCLink software configuration for proving and calibration. The 

Dattus meter communicates its uncorrected volume to the prover through a pulse. The 

output being sent from the Dattus meter must match prover configuration to get the best 

results.  

 

Caution  PCLink configuration must ensure the Dattus output pulse is set to a 
known quantity and matches the Prover setup configuration. 

  

Pulse Output Configuration 

The Dattus transfer proving cable (P/N 442405-003) connects the Dattus Output Channel 1 

(seeDattus Basic-L on page 16) to the appropriate pins connection on the input/output (IO) 

connector for the junction box. The factory set pulse output 1 configuration is shown on the 

Dattus original Certificate of Calibration. Pulse output 1 is a user-configurable value and 

may have changed. 

 

Note  For help in logging on and navigating PCLink software, 

please see PCLink Software Basics. 

Configure the Output 1 Pulse Weight on the PCLink Pulse Output tab to the required 

volume as shown in the following figure.  The Output 1 Pulse weight is typically 10 CF or 1 

CF.  
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Roots Model 5 Software Setup 

These Roots Model 5 software setup instructions are basic configuration requirements for 

working with a Dattus meter. These instructions assume a user's working knowledge of the 

Model 5 Software.  

To launch and configure the Roots Model 5 Software   

1. Launch the Roots software. 
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2. Select Configure/Run Meter Test. 

 

3. Select > Test Control Mode > Optical Scanner. 

 

 

Caution  Verify the Volume and Drive Rate/PPT are configured correctly. The 
Drive Rate/PPT should be the Volume divided by the Pulse Output 1 Pulse 
Weight setting from PCLink.  For example, if you have a test volume of 200 and 
a pulse output of 10, the PPT should be 20 (200/10). 
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Test Configurations 

Testing the Dattus meter with the Model 5 prover is accurate on the 10M from 500 CFH to 

8500 CFH. Below 500 CFH, the pulsation frequency becomes low enough that the 

dampener does not adequately dampen and skewed results are possible. For testing flow 

rates below 500 CFH, Itron recommends using another technology such as sonic or bell 

testing. Above 7000 CFH, the Dattus meter's (fM2 model) pressure drop and the dampener 

put a significant strain on the blowers and may reach the maximum flow obtainable without 

removing the dampener and choke valve. 
 

Suggested Test Configurations 

Users must decide the flow rates to test. Generally, two points are tested, high flow and low 

flow (also called Open and Check flows). The only limit is the meter's maximum capacity.  

The following table lists possible testing configurations for various flow rates: 

Flow Rate 
(CFH) 

Test Volume 
(CF) 

Drive 
Rate/PPT 

Output Pulse 
Weight (CF) 

Choke Valve 
Position 

8500 200 20 10 Open 

8000 200 20 10 Open 

7000 200 20 10 Open 

5000 200 20 10 Open 

3000 100 10 10 Closed 

2200 100 10 10 Closed 

1400 50 50 1 Closed 

1100 50 50 1 Closed 

1000 50 50 1 Closed 

700 30 30 1 Closed 

600 30 30 1 Closed 

500 30 30 1 Closed 

 

Note  At a minimum, try to configure the test setup for at least 10 pulses 

and at least one minute in test duration. This minimum configuration 

should ensure good resolution. 
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Modifying the Calibration Factor 

The Dattus meter measures gas by counting the number of oscillations it detects and 

multiplying the number of oscillations by the oscillation pulse weight (or calibration factor). 

The calibration factor is a single volume quantity determined through testing and defined in 

the meter's electronics. The calibration factor may be modified by the user through PCLink. 

Any adjustments will modify the accuracy at all points (flow rates). 

 

Note   Calibration factor modifications require the appropriate security access. 

 

Adjustment Calculation 

Your company's standard practices will determine any calibration factor adjustment applied 

to the Dattus meter. PCLink provides a tool to help calculate new oscillation pulse weights.  

To access PCLink's Pulse Weight Proving tool 

1. Start PCLink. 

2. Select Tools > Pulse Weight Proving.  

3. Enter the tested flow rates and the resulting error. The calculator can provide the user 

with a recommended new oscillation pulse weight. The following example shows an 

adjustment calculation. 

 

 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


 PCLink Calibration Procedure  

TDC-0853-001 Dattus Meter Technical Reference Guide  79 

 Proprietary and Confidential 
 

 

PCLink Calibration Procedure 

Configure the Oscillation Pulse Weight on PCLink's Calibration tab. The Oscillation 

Pulse Weight can be configured for ft3/pulse or m3/pulse representing the actual volume 

per oscillation.  

 

To configure the Oscillation Pulse Weight 

1. If you determine that the meter should be sped up or slowed down, insert the 

calibration change (in percentage) in the Adjust field. The percentage change is 

positive (to speed up) or negative (to slow down).   

2. After entering the calibration change value, click Calculate to modify the oscillation 

pulse weight. (If you calculated the adjustment with the Pulse Weight Tool, you can 

enter the oscillation pulse weight and then click the Program icon to write this value 

into the electronics of the meter.) 

 

Caution  Observe Dattus adjustment limits. Adjustment limits are determined 
through factory testing and define the reasonable minimum and maximum 
calibration factors expectations. If you attempt to program a meter calibration  
outside the adjustment limits, a warning box will display. 
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Differential pressure testing is a simple procedure where pressure drop, expressed in inches 

of water column, is measured between the meter inlet and outlet. 
 

Industry Uses and Applications 

This differential pressure testing method is used to assess rotary meter accuracy changes 

while in use in the field. Excessive dirt build-up on the rotary meter's impellers or wear on 

the meter's bearings can increase friction resulting in altered accuracy and a high differential 

pressure. Pressure readings taken across the meter are used to indicate whether or not the 

meter has an acceptable accuracy level. Rotary meter manufacturers and individual utilities 

established differential limits that infer acceptable/unacceptable meter accuracy. 
 

Dattus Meter Application 

The Dattus meter has no moving parts so the meter does not experience an increase in 

differential pressure associated with worn parts. Dattus meter differential tests are directly 

linked to gas flow rates through the meter and inferentially to the accuracy. 

 

Caution  Using differential testing to confirm Dattus accuracy is most 
successful when flow rate and pressure conditions are stable and the flow rate 
is high enough to generate a minimum 0.2 inches water column pressure drop. 

 

C H A P T E R  8  

Differential Pressure Testing 
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Dattus Differential Tables 

The following tables list differential pressures (for atmospheric pressure and 0.6 specific 

gravity gas) at common flow rates.   Refer to the graphs shown in Differential Pressure 

Curves for additional differential data. 

 

Dattus fM2 Model 

Flow Rate (ft3/h) 2" ANSI 125, in w.c. 3" ANSI 125, in w.c. 

9,100 5.60 5.00 

9,000 5.48 4.89 

8,600 5.00 4.48 

7,000 3.28 3.01 

5,700 2.17 2.00 

5,500 2.00 1.89 

5,000 1.67 1.57 

3,950 1.05 1.00 

3,850 1.00 0.95 

3,000 0.61 0.59 

 

 

Dattus fM3 Model 

Flow Rate  (ft3/h) 4" ANSI 125, in w.c. 

56,000 34.37 

38,000 15.35 

31,000 10.00 

23,000 5.47 

16,000 2.61 

14,050 2.00 

12,200 1.50 

11,000 1.22 

10,000 1.00 

7,100 0.50 

7,000 0.48 

5,000 0.24 
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Required Differential Pressure Testing Materials 

Differential pressure testing requires the following materials: 

 Pressure gauge. 

 Differential pressure gauge or manometer with a pressure capability level meeting the 

operating meter's demands. 

 Dattus differential pressure curves from this manual or spreadsheet. 

 Determining measured flow rate by clocking the meter or by direct communications 

using PCLink. 
 

Differential Test Overview 

The Differential Test procedure includes determining: 

 Pressures. 

 Flow rates. 

 Comparison differential. 
 

To determine pressures 

1. Measure and record gauge line pressure. 

2. Using the differential pressure gauge, determine the pressure drop. Use the pressure 

drop between the inlet and outlet.   

 

 

A Inlet 

B Outlet 
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Determining Flow Rate 

Determining the measured actual flow rate or uncorrected flow rate is best done under stable 

flow rates with a minimum of 0.2 inches w.c (water column) pressure drop. Determining 

measured flow rate can be done one of two ways: 

1. Using PCLink communications to the meter. 

2. Clocking the meter.  

 

To determine flow rate using PCLink communications 

1. Log on to meter. 

2. Select Modbus Parameters > Instantaneous Values. 

3. Click Start on the associated Flow Rate box. 

 

4. Use the Uncorrected value. 

To determine flow rate using meter clocking 

1. Use the Flow Indicator on the LCD. Use meter clocking only if the meter is 

configured to display uncorrected volume.  

2. Ascertain the multiplier for the LCD (typically CFx100). The flow indicator 

arrows will have a value of 1/10 of the display multiplier (or typically 10 CF). 

3. When gas flows through the meter, the rolling icon symbol (if enabled) displays 

on the left-hand side of the LCD below the volume read with a  sequence in the 

following pattern: 

 

      (Indicates 1st increment) 

          (Indicates 2nd increment)  

            (Indicates 3rd increment) 

            (Indicates 4th increment) 

        --------    (Blank corresponding to the 5th increment) 

4. The sequence then starts over. You will see two of these sequences per increment 

of the volume display on the LCD. 

5. Start the stopwatch as soon as the next icon shows on the LCD after you are ready 

to clock the meter.   

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


 Calculating Accuracy  

TDC-0853-001 Dattus Meter Technical Reference Guide  85 

 Proprietary and Confidential 
 

6. Wait for at least 2 increments and 30 seconds. Using these as minimums should 

give good resolution to determine the flow rate. Stop the clock when the next icon 

increments.   

7. Flow rate in actual cubic feet per hour (or uncorrected CFH) is calculated by: 

Flow rate = (3600/time in seconds) * (# increments * volume per increment) 

For example, using CFx100 as the displayed multiplier and 10 CF as the icon increment, the flow rate 

would be calculated:  

  (Indicates 1 increment, or 10 CF) 

      (Indicates 2 increments)  Start stopwatch 

       (Indicates 3 increments) 

           (Indicates 4 increments)  Stop stopwatch 

 -------- (blank corresponding to the 5th increment) 

   

The system took 36 seconds for two increments or 20 cubic feet.  Flow rate is calculated: 

Flow rate = ((3600 seconds/hr) /(36 seconds)) * (2 increments* 10 CF/increment) 

 = (3600/36) * 20 CF 

 = 100/hr * 20 CF = 2000 CFH 
 

To determine comparison differential from graphs 

1. Note the flange size of the meter and the line pressure. 

2. Based on these values, select the appropriate graph from Graph 8.1 to Graph 8.15 (see 

Differential Pressure Curves on page 87). 

3. Follow the appropriate curve to the point that matches the differential (in inches w.c.). 

4. Determine from the curve the flow rate based on your flange size and pressure 

conditions. 
 

Calculating Accuracy 

To determine accuracy, we compare the desired flow rate (based on the line pressure, flange 

size, and differential) to the actual flow rate the meter measured (based on clocking or 

interrogating the meter). 
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Variables difficult to control or measure introduce error (see Test Result Factors on page 

86). Consider variables when you compare the measured flow rate against the desired flow 

rate range. To mitigate difficult or uncontrollable variables, use a range of +/- 10% of the 

differential and use the range of flow it represents. 

Example: 

Suppose a 0.50" differential measurement was taken on a 2" FM2 meter with a line pressure 

of 10 psig. From the appropriate chart, applying a differential range of .45" to .55" w.c. 

gives an approximate expected flow rate range of 1900 to 2100 CFH.   Assuming we 

clocked the meter at 2000 CFH (as in the example), we see the measured flow rate is in line 

with the expected flow rate. From this, we assume the meter is measuring properly. 

 

Note  Ask your Itron sales representative for a Microsoft® Excel-based 

graphing tool to facilitate your differential testing. 

 
 

Test Result Factors 

Meter model, flow rate, line pressure, and measured differential pressure are used to make 

Dattus accuracy calculations. These values provide a guideline to ensure the Dattus is 

operating and measuring properly. There are a number of factors that can skew differential 

versus flow rate calculation results: 

 Specific gravity. All graphs assume 0.6 specific gravity gas. A variation 0.58 to 

0.62 represents a 7% range in differential pressure at a given flow rate. 

 Dattus body. The graphs represent average differential. There are slight variations 

meter to meter that can account for as much as 1% variation in differential pressure. 

 Pressure Gauges. There is an error range (associated with the gauges) used to 

determine line pressure and differential pressure.   

 Line Pressure. There is an error associated with an uncharted line pressure.  For 

example, we measure the 5.2 psig but use the 5 psig graph.  This can be factored 

out. 

 Atmospheric Pressure. The differential was determined at the factory by a pulling a 

vacuum on the meter at the prevailing atmospheric pressure (approximately 14.5 

psi) when the tests were conducted. If the atmospheric pressure at the site is 

significantly different, there will be a noticeable effect on the differential relative to 

flow rate.   
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Dattus Differential Pressure Curves 

Graph 8.1: Dattus FM2 2" at Atmospheric Pressure 

 

Flow Rate (ACFH) 
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Dattus FM2 3" at Atmospheric Pressure 

 

Flow Rate (ACFH) 
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Dattus FM2 2" at Medium Pressures (up to 5000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM2 2" at Medium Pressures (up to 11,000 ACFH) 

 

Flow rate (ACFH) 
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Dattus FM2 2" at Higher Pressures (up to 5000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM2 2" at Higher Pressures (up to 11,000 ACFH) 

 

Flow rate (ACFH) 
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Dattus FM2 3" at Medium Pressures (up to 5000 ACFH) 

 

Flow Rate (ACFH) 

 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Chapter 8 Differential Pressure Testing  

94 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

Dattus FM2 3" at Medium Pressures (up to 11,000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM2 3" at Higher Pressures (up to 5000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM2 3" at Higher Pressures (up to 11,000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM3 4" at Atmospheric Pressure 

 

Flow Rate (ACFH) 
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Dattus FM3 4" at Medium Pressures (up to 30,000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM3 4" at Medium Pressures (up to 56,000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM3 4" at Higher Pressures (up to 30,000 ACFH) 

 

Flow Rate (ACFH) 
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Dattus FM3 4" at Higher Pressures (up to 56,000 ACFH) 

 

Flow Rate (ACFH) 
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Determine the alarm status or alarm history of the Dattus meter visually through alarm 

indications on the LCD, through PCLink communications to the meter, or through 

configured pulse outputs (see Pulse Outputs). 
 

Liquid Crystal (LCD) Display 

This chapter focuses on the LCD Display's Alarm and Battery indicators. For general LCD 

information, see LC2 Liquid Crystal Display (LCD) on page 18. For LCD Flow Indicator 

information, see and Determining Flow Rate on page 84. 

 

A Flow Indicators 

B Alarm Indicators 

C Battery Indicators 
 

Live / Saved Alarms (LC2) 

Alarm Indicator  

Live Alarm. Three decimal points flash in the event of a live alarm.  

Saved Alarm. Three decimal points are a constant ON. 

The alarm description flashes on the LCD display every 12 seconds. 

Battery Indicator 

A flashing battery indicator signals a low battery alarm.  

All alarms are recorded in the Dattus meter's Event Log. A visual alarm indication is shown 

on the PCLink Status Tab. 

 

Caution  Inactive saved alarms may be automatically cleared from the LCD, 
dependent on the Dattus programming configuration. Automatically clearing 
inactive alarms is enabled or disabled using PCLink.  

C H A P T E R  9  

Alarms 
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LC2 Alarms 
LCD Alarm Display Description Action 

000.0.0.0 

 

Low Battery Alarm. Indicated by a flashing battery 

symbol. Change the primary, secondary, or both 

batteries. 

Replace meter batteries (at a minimum, replace 

the primary battery). 

0 - F.L.0. 

 

Overflow Alarm. Indicates one of two alarms. 

Overflow. User configurable for desired flow (as 

long as it is less than the meter's maximum 

capacity). 

Over Device Limit. Indicates meter exceeded 

the maximum capacity. 

Over Device Limit typically caused by temporary 

high gas flow (usually occurs at installation 

startup) or the Dattus is undersized for this 

application and should be upgraded or replaced 

with larger capacity meter.  

SEN.S. - . 1 

 

Sensor 1 Failure. Indicates sensor pair 1 is broken 

(failed) or it is disconnected from the electronics. 

Dattus will operate on secondary sensor pair. To 

ensure redundant sensors, repair sensor pair 1. 

SEN.S. - 2 

 

Sensor 2 Failure. Indicates sensor pair 2 is broken 

(failed) or it is disconnected from the electronics. 

Dattus will operate on primary sensor pair. To 

ensure redundant sensors, repair sensor pair 2. 

- HE.L.P. - 

 

HELP. Indicates both sensor pairs are broken or are 

disconnected from the electronics, measurement is 

stopped. HELP will remain on the LCD until the unit is 

repaired.  

Dattus is not operational. Repair is required.  

- SYNC - 

 

SYNC. Indicates a synchronization problem between 

the measurement electronics and the LCD. 

Usually temporary. Displays after installing new 

batteries or during a top of the hour 

synchronization. If SYNC remains displayed, 

there may be a problem with the circuit board or 

connection. Repair is required. 

Error 

 

Error. Indicates either a bad pressure or bad 

temperature reading. 

Log on to the meter and view the Corrector side 

status tab. If the problem persists, check the 

temperature and/or pressure. Thresholds may need 

adjustment. 
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Live/Saved Alarms (DS1) 

Alarms are classified as Live or Saved and are displayed numerically.  

 

Live Alarm DS1 

 

Saved Alarm DS1 

 

Coded alarms are deciphered through the Alarm Decoder.  

 

Caution  Inactive saved alarms may be automatically cleared from the LCD, 
dependent on the Dattus programming configuration. Automatically clearing 
inactive alarms is enabled or disabled using PCLink.  
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DS1 Display Alarms 

 

LCD Alarm Description Action 

             

X-filled circle. Indicates synchronization 

between the DS1 board and the DM2 

board is requested.  

This alarm is briefly displayed 

onscreen. If the icon remains 

indefinitely, contact Itron Technical 

Support. 

             

Clock. The corrector is checking for 

scheduled tasks. 

This alarm should frequently display 

around the top of the new hour. 

             

Phone. Indicates an RS-232 

communication attempt. 

This alarm displays during a logon 

attempt. It does not indicate a 

problem. 

             

Battery. Indicates low power for primary, 

secondary, or both batteries. 

This alarm signals a need to replace 

(at least) the primary battery. If this 

alarm displays before the fifth-year of 

use, investigate for a potential 

problem. 

            

Bell. Indicates a live corrector alarm. Log on to the Dattus meter (using 

PCLink) to view the Corrector status 

tab to investigate the alarm's nature. 

            

x-filled bell. Indicates a saved DS1 

alarm(s).  

      Note  If live alarms are also  

       present, the bell-X symbol will  

       remain displayed. 

Log on to the Dattus meter (using 

PCLink) and clear all saved alarms.  
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Using PCLink to View Alarms 

 

Note   See PCLink Software Basics for information regarding installation and 

log on to the Dattus meter using PCLink. 

 
 

Meter (DM2) Alarms 

Primarily read-only, the Status tab in PCLink provides alarm status information.   

 

Alarm Description 

Primary battery low Triggered when the battery voltage goes below 3.1V. 

Second battery low Triggered when the battery voltage goes below 3.1V. 

Primary battery disconnected Indicates either a disconnected battery or very low voltage. 

Second battery disconnected Indicates either a disconnected battery or very low voltage. 

Primary power supply 
Indicates a disconnection, very low voltage, or primary power circuit 

problem. 

Second power supply 
Indicates a disconnection, very low voltage, or secondary power circuit 

problem. 

Sensor 1 failure Indicates a disconnected or broken Sensor 1 pair. 

Sensor 2 failure Indicates a disconnected or broken Sensor 2 pair. 

Overflow warning  
Indicates the flow rate exceeded the user programmable quantity.  Refer to 

Meter Volumes (Volumes Tab). 

Device limit warning Indicates the flow rate exceeded the maximum capacity of the meter.  

Use of alarm volume 
Indicates volume registration into the volume under alarm register (refer to 

Meter Volumes (Volumes Tab). This is rarely used. 

Signal quality warning 
Indicates erratic sensor oscillation detection to the degree that the erratic 

sensor oscillation is compromising accuracy. 
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Corrector (DS1) Alarms 

 

Alarm  Description 

Bad Temperature Reading Indicates a temperature probe misread. 

Bad Pressure Reading Indicates a pressure reading misread. 

Temperature Out of Range Indicates temperature is out of configured threshold range limits. 

Pressure Out of Range Indicates pressure is out of configured threshold range.  

AGA 8 Outside Table Limit Indicates AGA 8 value is not listed in the generated table. 

DS1 Restarts Indicates the DS1 board rebooted. 

Battery 1 Indicates a low battery 1 reading. 

Battery 2 Indicates a low battery 2 reading. 

Sensor 1 Indicates sensor 1 is damaged. 

Sensor 2 Indicates sensor 2 is damaged. 

Overflow Uncorrected Indicates the corrected flow rate exceeds the meter's capacity. 

Overflow Corrected Indicates the corrected flow rate exceeds the user programmed value. 

Over Device Limit Indicates the flow rate exceeds the meter capacity. 

Use of Volume Under Alarm Indicates the volume accumulated during an alarm. 

Signal Quality Indicates the sensor detected erratic oscillation that is compromising accuracy. 

DM2 Restarts Indicates the DM2 board rebooted. 
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Using PCLink to Reset Alarms 

 

Note  This section applies primarily to saved alarms. Unless the cause of the 

live alarm is eliminated, the saved alarm will typically display again at the top 

of the next hour (dependent on alarm type). 

There are two methods for clearing or resetting Dattus alarms.  

1. Automatically clear saved alarms after a set number of days through a 

configuration setting.  

2. Manually log on to the Dattus using PCLink and reset the alarms. 
 

Alarm Options 

PCLink's Alarm Options configuration tab allows users to configure the Dattus to 

automatically reset any saved alarms after a programmed number of days (between 1 and 

15).  Refer to the following figure. 

 

 
 

To manually reset Alarms using PCLink 

1. Log on to the meter using PCLink. Go the Status Tab (either the Meter or Corrector 

Status tab). The Reset icon is available only when the Status Tab is active.   
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2. Click the Reset icon. 

Note  Clicking the Reset icon will display the Reset Device dialog.  

 

 

 

 

3. Select the items to clear in the Select items to reset area.   

4. After selecting the items, click the Perform Action button to reset the alarms or clear 

recorded information.  
 

PCLink Alarm Decoder 

While the alarm indicators displayed on the meter indicate an active or saved alarm, they do 

not tell the exact nature of the alarm. By default, most Dattus Corrector meters are 

configured to display live and saved alarm codes for the meter. To decipher the meaning of 

the codes, use the PCLink Alarm decoder. The Alarm Decoder does not require a 

connection to the meter and no log on action is required during the process.  
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To access the Alarm Decoder 

1. Open PCLink. Select Tools > Alarm Decoder. 

 

2. After the Alarm Decoder opens, select the DS1 Tab. 
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3. Enter the alarm code number in the upper right text box.  

 

4. A corresponding check mark(s) displays next to the associated alarm. 
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This chapter describes the software configuration for Dattus pulse outputs and provides 

schematic basics to connect the Dattus using a pulse output cable to auxiliary devices. 
 

Required Materials 

Connecting pulse outputs from the Dattus meter requires: 

 Pulse output cable. 

 Computer running PCLink software. 

 Communication cable. 

 Any additional items to run cable or connect auxiliary devices. 

If the pulse outputs were configured at the factory, communications to the Dattus are not 

required; simply make the physical connections (see the Certificate of Calibration on page 

143 to verify factory configured pulse outputs).  
 

Output Channel Overview 

The Dattus meter is equipped with four pulse output channels. Pulse output configuration 

(factory programming) is listed on the Certificate of Calibration included with each Dattus 

meter. 

 

C H A P T E R  1 0  

Dattus Pulse Outputs Overview 
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The following table describes the four pulse outputs. 

Output Channel Purpose 

Output 1 Output 1 is physically wired to prove/calibrate the Dattus meter with the transfer 

proving cable (Itron part number ). It may be used for any user applications/purpose.  

Output 2 Output 2 communicates information from the metrology board (DM2) or Corrector 

(DS1) to the display (LCD readout). Output 2 is not configurable through the pulse 

output tab. Output 2 may be used (piggybacked) providing output configuration meets 

the user's needs. 

Output 3 Output 3 is a customer output channel and offers the most flexibility. Output 3 is 

designed specifically for user configuration.  

Output 4 Output 4 is a customer output channel and offers the most flexibility. Output 4 is 

designed specifically for user configuration.  

 
 

Electrical Schematic and Connection Specifications 

Dattus meter output circuitry provides the following features: 

 Non-isolated. 

 Dry contact. 

 Open drain N channel MOSFET. 

 240 ohm contact resistance (R). 

 Common/negative connection to the meter body. 

 Zener diode provides reverse current protection. 

Specifications: output connections  

 Up to 35 VDC DC voltage only. 

 To maintain intrinsic safety (UL 913 CSA 22.2), up to 16 VDC. 

 Maximum current of 25 mA. 
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Hardware Setup 

A meter connector provides the connection for the pulse outputs on the Dattus meter; a six-

pin binder connector on the meter's face labeled 1.   

 

To use the pulse output, an output cable is required. Pulse output cables have a binder 

connector on one end (that screw onto the binder connector on the meter) and bare lead 

connections on the other end (to attach to the auxiliary device).  

 

Standard pulse output cables  

Pulse output cable length Itron part number 

10 feet 442461-005 

20 feet 442461-006 

 

Male binder connector pin-out 
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Pulse output cable 

Pin Wire color Function 

1 White Output 2 (+) 

2 Black Output 4 (+) 

3 Green Ground (-) 

4 Orange Output 3 (+) 

5 Red Output 1 (+) 

6 Blue Ground (-) 

 

 

Note  The blue and green ground connections are tied together in the Dattus 

meter to the meter body. All channels have a common ground; they are non-

isolated. 

 
 

Addressing Special Applications 

The standard output cable and setup are compatible for most applications however, in some 

applications, the Dattus meter's pulse outputs are not directly compatible with auxiliary 

devices. Special applications are more typical in industrial applications where a wide range 

of devices are used.  For example: 

 The 240 ohm contact resistance is higher than device allowable maximum. 

 The device requires an isolated output. 

 The device provides AC voltage. 

 The device requires a wetted output. 

For special applications, Itron offers a pulse cable option (with a built-in MOSFET 

transistor for contact resistance bypass). Pulse option cables have a binder connector on one 

end (that screw onto the binder connector on the meter) and bare lead connections on the 

other end (to attach to the auxiliary device). The pulse cable is a 3-wire connection, but will 

also work with 2-wire connections (to offer contact resistance bypass). This cable may be 

used in conjunction with a power supply (to address a wetted output application) or a power 

supply and relay (to address requirements for either an isolated output or an AC voltage 

application). 
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Itron optional pulse cables (open source P, Channel MOSFET and wetted 
output applications) 

Pulse Cable Length Itron Part Number 

10 feet 442461-007 

20 feet 442461-008 

Itron pulse cables only connect to outputs 3 and 4 with output 3 providing the only 

connection with open source P – Channel MOSFET. Channel 4 is a standard output 

connection. The table below shows the 4 bare lead wires and their function for these cables. 

Itron optional pulse cable bare wire leads and functions 

Output Wire color Function 

 
Output 3 

Red Power supply (+) 

White Signal 

Output 4 Black Output 4 (+) 

Common to both Green Power supply (-) and ground for 

outputs 3 and 4 

 

Note  Itron's optional pulse output cable's maximum power supply voltage is 18 

VDC due to the transistor's operation and interaction with the output circuitry's 

zener diode.  

Two wire connections 

For applications with two wire connections (+ and -) for contact resistance: 

 Connect the red wire to + on the device 

 Connect both the signal (white) and ground (green) to the negative/common. 

Using a relay with the optional pulse output cable 

For some applications, Itron recommends the use of a relay in conjunction the pulse output 

cable to separate the auxiliary device circuit from the Dattus output circuit.  These 

applications include: 

 Auxiliary devices with voltage above 18V. 

 AC powered devices. 

 Devices that require an isolated output. 

 

 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Chapter 10 Dattus Pulse Outputs Overview  

118 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

Pulse Output Channel Software Configurations 

This section provides software configurations for output channels 3 and 4 because they are 

the most commonly used and configured channels for auxiliary equipment. The figure 

below shows an output pulse channel configuration example. 

 

Type 

Output Type Description 

None Deactivates the channel output. 

Uncorrected Uncorrected volume output. 

Mux uncorrected Do not use. 

Corrected Corrected volume output. See Key Output 

Configuration Limitations on page 119. 

Alarm Activates a switch closure. Discrete output type. 

Mode 

Mode allows configuration of the pulse outputs operating modes.  Mode is available for 

only Uncorrected or Corrected Pulse Types. 

Output Mode Description 

Selectable Duty Allows the user to specify the pulse width. 

Specifying a pulse width specifies the length of time 

the contact will close. See Selectable Duty  

50% Duty Cycle Selecting 50% Duty Cycle specifies the contact will 

close 50% of the time. 50% Duty Cycle does not 

impose a flow rate limitation. 50% Duty Cycle my 

cause more power drain on auxiliary equipment 

(dependent on configuration).  

High Frequency (HF) Output HF output frequency is proportional to flow rate. The 

maximum output frequency is 512 Hz at a user-

defined flow rate. (For Basic-L meters, see Meter 

Volumes (Volumes Tab). For meters equipped with 

a DS1, see DS1 Volumes Tab. The minimum 

frequency is 0.5 HZ at zero.  
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Pulse Weight  

You may select a pulse weight for your output if your Output Type is Corrected or 

Uncorrected and your mode is 50% or Selectable duty cycle. 
 

Key Output Configuration Limitations 

PCLink's Pulse Output configuration tab provides helpful information about pulse output 

configuration limitations. Configuration limitation information displays under the Pulse 

weight data entry box.  

When programming: Configuration limitation consideration: 

Corrected volume Correction factor does not exceed maximum. 

Selectable duty  Flow rate does not exceed admissible maximum flow. 

 Pulse width. 

Pulse weight Pulse weight must be the least minimum required. 

High Frequency (HF) Frequency output is based on a calculated flow rate. The HF output will not always 

match the actual flow rate. Varying loads and flow rate speed (particularly slowing 

flow rates) affect HF outputs. (See HF Output.) 

Corrected Volume 

When selecting Corrected as the Pulse Output Type, pay careful attention to the 

Correction Factor must be less than. 

 

The Correction Factor is calculated by (Pulse Weight) / (Oscillation Pulse Weight). If the 

Correction Factor multiplied by the oscillation pulse is larger than the pulse output, the 

meter would attempt to send more than one pulse out for every pulse in, which is 

impossible. (For Corrector models, the method to calculate Correction Factor is (Pulse 

Weight) / (Input Pulse Weight.) 
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Selectable Duty 

When Mode is configured for Selectable Duty, the meter uses a specific pulse width 

creating a maximum flow limitation. The Selectable Pulse Width configuration entry box is 

only available when Mode is configured for Selectable Duty. 

 

The pulse width duration is the time the contact is closed and the minimum time the pulse is 

open. A 0.250 second pulse width means it will take 0.50 seconds for a complete pulse 

cycle. In this example, 2 cycles per second (2 Hz) is the maximum output rate. 

 

Caution  Pulse width has a 10 millisecond (0.010 seconds) minimum and a 
1.75 second maximum.  

The admissible maximum flow rate is a calculation based on the pulse width and the pulse 

weight. For example (see the figures above and below), with a 1.00 CF/pulse weight and a 

0.250 second pulse width, the maximum flow rate is 7200 CFH before the pulses become 

saturated and lose pulses (maximum pulse rate 2 per second [7200 per hour] and 1 CF pulse 

weight).   
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Pulse Weight 

Pulse weight is limited based on the Dattus model. 

 Basic-L Dattus models. 2 times the oscillation weight limit. 

 DS1 Dattus models. 1 times the input pulse weight limit.  

There are no maximums specified but Itron recommends you do not exceed 1000 CF (or 

m3) per pulse. An out of range error will display if either pulse width is outside acceptable 

parameters or the pulse weight is not above the minimum requirements. 

 

High Frequency Output 

Dattus Basic Meters 

Basic Dattus meters calculate the instantaneous flow rate (based on the last 40 oscillations) 

as a percentage of the scale (see Meter Volumes (Volumes Tab) on page 47. The resulting 

fraction is applied to 512 Hz to obtain the output frequency. Since the HF output is 

dependent on the instantaneous flow rate calculation, the output can lag the real flow rate 

and appear to (slightly) jump around as each new calculation is factored.  

Typically, the HF output responds faster to increased flow rate than in decreased flow rates 

(because 40 oscillation occur at faster rates in increasing flows than decreasing flows). The 

timeout period (or zero flow) is approximately 20 seconds. The meter's minimum flow rate 

is about one oscillation every 20 seconds.  

The primary HF output application is to feed pulses to current and voltage converters where 

the normal pulse (selectable duty or 50% duty cycle) may be below minimum.  
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Corrector Models 

All DS1 Dattus corrector models calculate instantaneous flow rates via the DS1 corrector 

board. The meter (DM2 board) collects uncorrected volume and sends pulses to the 

corrector (DS1) board. Dattus corrector versions calculate instantaneous flow rate based on 

8 input volume pulses from the meter to the corrector. These input pulse values are visible 

in the Uncorrected Input Volume window located on the Input Config tab on page 49.  

 

Caution  HF Output is not a volume output. HF Output will not provide accuracy 
for counting the pulse number from the HF output to calculate volume. The 
inaccuracy degree (compared to a volumetric pulse) will depend on flow rate, 
flow rate change frequencies, time at zero flow, and other variables.  

When the Dattus has a zero (0) flow rate, the HF output will send pulses at 0.5 
Hz to indicate a functioning output. The zero flow rate pulses may be zeroed out 
for auxiliary equipment using the HF output.  
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This chapter provides a demonstration of a Dattus meter remote read option using Modbus 

communication. Communication to the  Dattus meter is typically accomplished using your 

PC/laptop Dattus RS-232 communication cable to connect to the meter. PCLink software 

allows users to log on to the meter to read specific meter information (essentially a Modbus 

RTU communication). Modbus communication allows you to read Dattus information (for 

example, Uncorrected or Corrected Volume) without a direct RS-232 communication cable 

or PCLink. 
 

Required Materials 

Dattus meter Modbus communications require the following materials. 

 Dattus Meter. 

 Modbus RTU device. This device must have an RS-232C input DTR connection. 

 Power supply to power the Modbus device as well as supply a 5V current to the 

meter from the Modbus device. 

 Software capable of register range reads of 50,000 to 59,999. 
 

General Dattus Modbus Setup 

To setup the Dattus for Modbus communications 

1. Apply power to the Modbus RTU device. 

2. Log on to the Modbus RTU device. 

3. Configure the Modbus device for the following settings: 

 Baud rate: 9600 

 8 bits 

 Even parity 

 1 stop bit 

4. Enter the Slave ID/address (default for the meter is 90, default for the corrector is 91).  

5. A Modbus Register List (Default Meter Address 90 and Default Corrector Address 91) 

follows these instructions. The list shows meter addresses, corrector addresses, register 

type (Long, Integer, Float), and function codes to read values. Use the Meter Register 

Addresses with the Modbus reading program.  

6. If the option is available, read values in Big Endian order (values are read from High 

Byte to Low Byte or High Word to Low Word).  
 

C H A P T E R  1 1  

Modbus Communication Overview 
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Modbus Register List 

 

Note  Use the following Modbus Register List table definitions for Type: 

 Long. Unsigned 32-bit integer. 

 Integer. Unsigned 16-bit integer. 

 Float. IEEE 754 32-bit floating point. 

Use Modbus read input registers (function code 4) and request 1 or 2 registers dependent on 

entity size. 

 

        Default Corrector Address 90 
 

 

Register Description Type Equation (if applicable) 

50095 Uncorrected Volume Long  

50141 Uncorrected Volume - decimal Float  

50145 Corrected Volume Long  

 

 

50135 

 

Unc Flow Rate - Current 

 

Long 

If Value = 0, then flow rate is 0 else 

   117964800 

=                         x OSC.PulseWeight 

       Value 

 

 

50110 

 

Unc Flow Rate - Maximum 

 

Long 

If Value = 0, then flow rate is 0 else 

   117964800 

=                          x OSC.PulseWeight 

        Value 

50091 Battery 1 voltage Integer 

                     5.0314 

= Value x  

                       4095 

50102 Battery 2 voltage  Integer 

                       3.9051625 

= Value x  

                           4095 

50117 Unc. Volume under alarm Long  

50064 Oscillation Pulse Weight Float  
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Default Corrector Address 91 

Register Description Type Equation 

51253 Uncorrected Volume Long  

52155 Corrected Volume Long  

52169 Uncorrected Flow Rate Float  

52171 Corrected Flow Rate Float  

52279 Live Pressure Float  

52325 Max Pressure Float  

52323 Min Pressure Float  

52066 Saved Alarms Integer Use Alarm Decoder in PCLink 

52065 Live Alarms Integer Use Alarm Decoder in PCLink 

52277 Live Temperature Float  

52321 Max Temperature Float  

52319 Min Temperature Float  

52177 Max Flow Rate Float  

52179 Corrected Flow Rate Float  

52145 Temp Correction Factor Float  

52147 Pressure Correction Factor Float  

52149 Super X Factor Float  

52151 Total Correction Factor Float  
 

Verifying and Changing the Slave Address 

Dattus default Slave Addresses for the meter and corrector are 90 (meter) and 91 (corrector). 

If a event a Modbus device occupies the slave address, it may be necessary to change the 

address. 

To verify (or change) the meter and connector Slave Address 

1. Connect an RS-232 communication cable (Itron part number 600204-001) to the 

Dattus. 

2. Open PCLink. 

3. Do not log on to the meter. 
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4. Select Tools > Change Slave Address. 

 

 

Warning  The meter and corrector must not share the same Slave Address. 
If the same address is selected, the meter will enter permanent lockup and 
render it permanently inaccessible.  

5. The PCLink - Modbus slave address window opens. Locations 1-255 are available 

(with the exception of address 73). Select the Dattus meter or corrector button (to view 

the current slave address).  

  

6. Click Read current address.  

 

Caution  Read the corrector and meter addresses prior to making changes. 
The new addresses must not match either of the current addresses! 

7. Read and make note of the addresses of both the meter and corrector.  

8. Select the meter or corrector address to change.  

9. Enter the new address for the selected device (meter or corrector) in the bottom 

(green) box.  

10. Click > Program new address. 
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Dattus meters feature configuration upgrades using a software or upgrade key. The upgrade 

key is an encrypted 75-digit number  specific for the meter and upgrade type. Each upgrade 

key is valid only for the meter it was designed to upgrade. The upgrade key is a *.pck 

(PCK) file that once opened (using PCLink) inserts the upgrade key number into the 

appropriate upgrade field (see Performing an Upgrade on page 128.)  
 

Dattus Upgradable Components 

The following Dattus components are upgradable: 

 Flow rate capacity. 

 Data logging enable. 

 Password reset. 

 Convert to metric. 
 

Flow Rate Capacity 

Flow rate capacity is the most commonly performed Dattus upgrade. A flow rate capacity 

upgrade allows the user to increase the meter's flow rate capacity (with the meter still 

installed and working) for a new increased load or to inventory less expensive, smaller 

capacity meters. Dattus flow rate capacity upgrades have the following constraints: 

 fM2. Upgrade from current capacity to a maximum of 11M. 

 fM3. Upgrade from current capacity to a maximum of 56M. 

  

Data Logging Enable 

A Dattus meter data logging enable upgrade gives the user access to data logging (creating 

an audit trail). 
 

Password Reset 

A Dattus password reset allows the user to reprogram the default Dattus password (see 

Default Passwords on page 37). A password reset is useful when a customer changed and 

forgotten a password. 
 

C H A P T E R  1 2  

Dattus Upgrade Overview 
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Metric Enable 

A Dattus metric enable upgrade converts the meter from imperial to metric (or metric to 

imperial) units.  

 

Note  A metric enable upgrade will change the LCD readout units and may 

introduce a discrepancy between the units printed (on the label) and those 

programmed into the meter. 
 

Upgrade Method 

The following information is required to generate a Dattus meter upgrade key. Contact your 

Itron sales representative with the following information. Your representative will supply 

the information to the factory where the upgrade key will be generated.  

 The Dattus serial number (typically a D followed by a 7-digit number). 

 The upgrade type (see Dattus Upgradeable Components on page 127). 

 If the upgrade type is flow rate capacity, your meter's current capacity rating. 
 

Upgrade Contents 

Your Dattus upgrade includes the following: 

 A .pck file sent by email (or alternate method). The PCK file is typically 

formatted as serial number - upgrade type - customer name - date created (for 

example, D1234567 - 2M to 5M - ABC Utility Co. - 02-28-10). 

 If the upgrade is a flow rate capacity upgrade, two manufacturer badges 

showing the new capacity and a capacity sticker. 

 

Note  New manufacturer badges for flow rate capacity upgrades typically do 

not list a serial number. If you require embossed badges, specify embossed 

badges at the time of the upgrade order. 
 

Performing an Upgrade 

After you receive the upgrade key, save it to the computer you will use to communicate with 

the meter. (Itron recommends saving the file in a temporary folder or on the desktop.) 
 

To upgrade the Dattus meter 

Note  To perform the meter upgrade, do not log on to the meter. If you are logged on, 

log off. Meter upgrade is only available when you are not logged on to the meter. 
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1. Start PCLink. Go to Tools > Meter upgrade. 

 

2. The Dattus upgrade window opens.  

 

3. You may manually enter the upgrade key or click Load KEY from file. (Itron 

recommends using the Load KEY from file option to eliminate entry errors.) Browse 

to the PCK file. The number automatically populates the field.  

4. Click Next. 

5. The upgrade process window opens.   

 

The upgrade process involves the following five-step process:  

 Logging On to Dattus meter. PCLink verifies it can communicate with the 

meter. 

 Validating factory serial number. PCLink verifies the key entered applies to the 

meter being upgraded. 

 Check KEY validity. PCLink verifies the upgrade key is valid for the specific 

upgrade. For example, a 3M to 11M upgrade key will not complete an upgrade 

if the meter is a 2M.  

 Upgrading/Modifying feature. PCLink is performing the upgrade. 

 Verifying checksum and completing upgrade. PCLink is completing the final 

checks. 
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6. After the upgrade is complete, the Next button becomes active. Click Next. If the 

upgrade was successful, the Congratulations window displays. If the upgrade fails, an 

Upgrade failed window displays. 

   

 

Note  Upgrade failures are typically caused by an upgrade key being applied to 

the incorrect meter or a mismatched factory serial number. If a Dattus upgrade 

fails, contact your Itron Sales Representative.  
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The Dattus meter requires very little routine maintenance. Generally, only periodic battery 

replacements are necessary. The meter has 2 D-cell lithium batteries.  The Dattus first uses 

the primary battery. If the primary battery is battery is depleted,  the meter switches to the 

backup or secondary battery. The meter's primary battery typically lasts four to six years 

before the battery requires replacement. 

 

Caution  The Dattus meter requires a constant power source to maintain 
measurements and power the LCD (LC2). In the event that both batteries are 
disconnected from the unit simultaneously, the meter will not register until 
power is restored. Itron recommends following the Dattus battery replacement 
guidelines to ensure at least one battery is connected to the meter at all times. 

  

Dattus Battery Replacement Guidelines 

When a battery alarm occurs (see Meter (DM2) Alarms on page 107) replace Dattus meter 

batteries using one of the following three Itron-recommended options: 

1. Order one new replacement battery. Replace the secondary battery with the new 

battery. Replace the primary battery with the secondary battery. Discard the primary 

battery following environmentally safe practices. Contact the EPA for more 

information.  

2. Order one new battery and replace the primary battery with the new battery. Discard 

the primary battery following environmentally safe practices. Contact the EPA for 

more information.  

3. Order two new batteries and replace the primary battery with a new battery. After the 

primary battery is replaced, replace the secondary battery with the remaining new 

battery. Discard the both batteries following environmentally safe practices. Contact 

the EPA for more information.  
 

To change batteries in the Dattus meter 

Caution  The Dattus meter requires a constant power source to maintain 

measurements and power the LCD (LC2). In the event that both batteries are 

disconnected from the unit simultaneously,  the meter will not register until power is 

restored. Itron recommends following the Dattus battery replacement guidelines to 

ensure at least one battery is connected to the meter at all times. 

C H A P T E R  1 3  

Dattus Meter Maintenance Overview 
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1. Remove the protective cover. 

 

2. Twist the battery door to unlock the battery door tabs. Remove the battery door. 

 

3. Remove the batteries following the Dattus Battery Replacement Guidelines on page 

131. 
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4. Install the new battery (batteries). Replace the battery in the meter with the connector-

end out. 

 

5. Replace the battery door, the Dattus meter cover, and meter seals (if necessary). 
 

3-way Valve 

All Dattus PTZ-L and P-only meters are equipped with a 3-way valve combined with a 

Pete’s plug, valve assembly tubing and pressure transducer. The 3-way valve regulates the 

location of the pressure that the transducer is measuring.  The valve itself can be accessed 

by removing the plastic grey cover. The valve positions and their possible uses are described 

in the following sections. 
 

Position 1 Standard Position (Pete's Plug sealed) 

The standard position is the default valve position for all meters. When the valve is left in 

position, the transducer is measuring the pressure currently going through the meter. The 

Pete’s Plug is sealed off in this position. 

 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Chapter 13 Dattus Meter Maintenance Overview  

134 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

Position 2 All Open 

This position is similar to the default standard position with one exception, the Pete’s Plug 

is no longer sealed off from the rest of the pressure. Position 2 All Open is an ideal mode for 

the pressure transducer's field calibration. A gage with a needle nose attachment could be 

placed in conjunction with the Pete’s plug to compare the pressure transducer to the gage. 

 
 

Position 3 Meter Sealed 

In Position 3, the meter is sealed from the pressure transducer and the Pete's Plug. In 

Position 3, an external pressure may be applied to the pressure assembly using the Pete's 

Plug. The applied pressure value can be checked using the live pressure calculation on the 

DS1 screen or PCLink. 
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Dattus fM Meter 
Flange 

Size 
Units 

fM2 
1M 

fM2 
1.5M 

fM2 
2M 

fM2 
3M 

fM2 
5M 

fM2 
7M 

fM2 
11M 

Read Capacity - ACFH 1000 1500 2000 3000 5000 7000 11000 

Maximum 
Capacity* 

- ACFH 1250 1875 2500 3750 6250 8750 13750 

MAOP - PSIG 150 150 150 150 150 150 150 

Dynamic Range  
+/- 1% 

- ratio 17:1 25:1 33:1 50:1 83:1 116:1 183:1 

Dynamic Range  
+/- 2% 

- ratio 45:1 68:1 91:1 136:1 227:1 318:1 500:1 

Flow Rate. 0.5" 
w.c., Gas 

2" FL ACFH ** ** ** 2457 2457 2457 2457 

3" FL ACFH ** ** ** 2750 2750 2750 2750 

4" FL ACFH NA NA NA NA NA NA NA 

Flow Rate. 1.0" 
w.c., Gas 

2" FL ACFH ** ** ** ** 3481 3481 3481 

3" FL ACFH ** ** ** ** 3871 3871 3871 

4" FL ACFH NA NA NA NA NA NA NA 

Flow Rate. 2.0" 
w.c., Gas 

2" FL ACFH ** ** ** ** 4918 4918 4918 

3" FL ACFH ** ** ** ** 5535 5535 5535 

4" FL ACFH NA NA NA NA NA NA NA 

Pressure Drop at 
Rated Capacity 

2" FL Inches w.c. 0.09 0.19 0.33 0.75 2.06 3.89 9.25 

3" FL Inches w.c. 0.05 0.14 0.26 0.61 1.64 3.14 7.55 

4" FL Inches w.c. NA NA NA NA NA NA NA 

Flange Connection 
Size 

- Inches 2" or 3" 2" or 3" 2" or 3" 2" or 3" 2" or 3" 2" or 3" 2" or 3" 

Flange to Flange 
Dimensions 

- Inches 6 3/4 6 3/4 6 3/4 6 3/4 6 3/4 6 3/4 6 3/4 

Weight - lbs. 37 37 37 37 37 37 37 

Shipping Weight - lbs. 42 42 42 42 42 42 42 
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fM2 Meter Sizing 

Meter Size 
fM2  
1M 

fM2 
1.5M 

fM2 
2M 

fM2 
3M 

fM2 
5M 

fM2 
7M 

fM2 
11M 

Rated Capacity 
ACFH 

1000 1500 2000 3000 5000 7000 11000 

Meter Pressure 
psig 

Metering capacity in MSCFH 

1 1.1 1.6 2.1 3.2 5.3 7.4 11.6 

5 1.3 2.0 2.6 4.0 6.6 9.3 14.6 

10 1.7 2.5 3.3 5.0 8.3 11.7 18.3 

15 2.0 3.0 4.0 6.0 10.0 14.0 22.1 

20 2.3 3.5 4.7 7.0 11.7 16.4 25.8 

25 2.7 4.0 5.4 8.1 13.4 18.8 29.6 

60 5.1 7.6 10.2 15.2 25.4 35.5 55.9 

90 7.1 10.7 14.3 21.4 35.6 49.9 78.4 

100 7.8 11.7 15.6 23.4 39.0 54.7 85.9 

150 11.2 16.8 22.4 33.7 56.1 78.6 123.4 
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fM3 Specifications 

Dattus fM Meter 
Flange 

Size 
Units 

fM3 
7M 

fM3 
11M 

fM3 
16M 

fM3 
23M 

fM3 
38M 

fM3 
56M 

Read Capacity - ACFH 7000 11000 16000 23000 38000 56000 

Maximum Capacity* - ACFH 8750 13750 20000 28750 47500 57000 

MAOP - PSIG 175 175 175 175 175 175 

Dynamic Range +/- 1% - ratio 70:1 110:1 160:1 230:1 380:1 560:1 

Dynamic Range +/- 2% - ratio 117:1 183:1 267:1 383:1 633:1 933:1 

Flow Rate. 0.5" w.c., Gas 4" FL ACFH 6650 6650 6650 6650 6650 6650 

Flow Rate. 1.0" w.c., Gas 4" FL ACFH ** 9350 9350 9350 9350 9350 

Flow Rate. 2.0" w.c., Gas 4" FL ACFH ** ** 13150 13151 13152 13153 

Pressure Drop at Rated 
Capacity 

4" FL 
Inches 

w.c. 
0.55 1.39 2.98 6.18 17.37 37.73 

Flange Connection Size - Inches 4" 4" 4" 4" 4" 4" 

Flange to Flange 
Dimensions 

- Inches 9 1/2 9 1/2 9 1/2 9 1/2 9 1/2 9 1/2 

Weight - lbs. 114 114 114 114 114 114 

Shipping Weight - lbs. 128 128 128 128 128 128 

 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Appendix A fM2 Specifications  

138 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

fM3 Meter Sizing 

Meter Size 
fM3 
1M 

fM3 
1.5M 

fM3 
2M 

fM3 
3M 

fM3 
5M 

fM3 
7M 

Rated Capacity 
ACFH 

7000 11000 16000 23000 38000 56000 

Meter Pressure 
psig 

Metering capacity In MSCFH 

1 7.4 11.6 16.8 24.2 39.9 58.9 

5 9.3 14.6 21.2 30.5 50.3 74.2 

10 11.7 18.3 26.6 38.3 63.3 93.3 

15 14.0 22.1 32.1 46.2 76.3 112.4 

20 16.4 25.8 37.6 54.0 89.2 131.5 

25 18.8 29.6 43.0 61.9 102.2 150.6 

60 35.5 55.9 81.3 116.8 193.0 284.4 

90 49.9 78.4 114.0 163.9 270.8 399.1 

100 54.7 85.9 124.9 179.6 296.7 437.3 

150 78.6 123.4 179.5 258.1 426.4 628.4 

175 90.5 142.2 206.9 297.4 491.3 724.0 
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Part Number Description 

600204-001 RS-232 communication cable used to connect a computer via serial port connection to the Dattus. 

442001-002 PCLink Software CD. 

442461-005 Pulse Cable 10'. 

442461-006 Pulse Cable 20'. 

442465-001 
9 ½" Flange Adapter Kit.  Spacer that adapts the FM2 3" to a 9 ½" Flange spread.  Helps 

accommodate for a change-out of a rotary 7M. 

442502-001 Pulsation Dampener Kit; Includes: pulsation dampening box, 3 ft. prover hose, choke valve. 

442405-003 Model 5 Transfer Prover Cable. 

442503-001 Choke Valve assembly (for use with Dresser dampening box). 

442461-007 P-channel MOSFET pulse cable 10’. 

442461-008 P-Channel MOSFET pulse cable 20’. 
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A P P E N D I X  D  

Certificate of Calibration 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


Appendix D Certificate of Calibration  

144 TDC-0853-001 Dattus Meter Technical Reference Guide 

 Proprietary and Confidential 
 

                                 | sales@mvandc.com | Phone: 877.566.3837 | Fax: 925.407.2903

http://www.mvandc.com


 

TDC-0853-001 Dattus Meter Technical Reference Guide  145 

 Proprietary and Confidential 
 

% Accuracy. The volume ratio registered by the meter divided by the volume registered by 

the reference, and multiplied by 100.  

% Accuracy = (meter volume / reference volume) x 100. 

% Error. The volume ratio registered by the meter minus the volume registered by the 

reference, divided by the reference volume, and multiplied by 100. % Error = {(meter 

volume- reference volume) / reference volume} x 100. 

% Proof. The ratio of the volume registered by the reference, divided by the volume 

registered by the meter, and multiplied by 100. % Proof = (reference volume /meter volume) 

x 100. 

Accuracy Curve. Graphical expression of accuracy of a meter as a function of flow. 

ACFH. Actual cubic feet per hour.  The meter reading without pressure, temperature, or 

compressibility correction. 

Ambient Temperature. The temperature of the atmosphere surrounding the equipment or 

area. 

Atmospheric Pressure. Measure of the weight of the earth's atmosphere at a given place and 

time. At sea level, atmospheric pressure is approximately 14.696 psia. 

Base (Standard Pressure). The standard pressure base condition used for the volumetric 

measurement of natural gas. ANSI/API 2562-1969 established 14.73 psia as the base 

pressure to which all volumes are commonly referred. Base pressure is normally defined in 

gas measurement contracts. 

Base (Standard Temperature). The standard temperature base condition used for the 

volumetric measurement of natural gas.  ANSI/API 2562-1969 established 60°F as the base 

temperature to which all volumes are commonly referred. 

Base Conditions. The standard pressure and temperature base conditions for the volumetric 

measurement of natural gas. ANSI/API 2562-1969 established 14.73 psi as the base 

pressure, and 60°F as the base temperature, to which all volumes are commonly referred. 

Compressibility. In gas measurement, volume decreases when there is an increase in 

pressure. Compressibility (Z) is the variance from the ideal gas law behavior. 

Corrected Volume. Meter volumes multiplied by the correction factor (volume after 

compensating for pressure and/or temperature). 

Correction Factor. Numerical factor (single constant or coming from a mathematical 

function) by which the uncorrected result of a measurement is multiplied to compensate for 

systematic error. 

A P P E N D I X  E  
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Differential Pressure. The difference in pressure (DP) between the inlet and outlet of a 

metering or regulating device. 

DM2. Dattus Metrology 2nd generation, specifically the circuit board performing the core 

measurement in the Dattus. 

Drift. Slow metrological characteristic change of a measuring instrument. 

Energy. The capacity to do work/heat (measured in the same units as work). Energy may be 

transferred from one form into another. 

Fixed Factor. (Also pressure factor measurement.) Used as a compensation factor when 

delivery pressure is higher than standard but variable pressure compensation is not used. See 

Correction Factor. 

Gauge Pressure. Measured pressure relative to atmospheric pressure taken as zero; 

abbreviated as psig. Measured pressure above atmospheric pressure. 

Index. The device displaying the volume of gas passing through the meter. 

LC2. The term for the LCD circuit board used on the Dattus Basic. 

MAOP (Maximum Allowable Operating Pressure).  The maximum safe operating pressure. 

Maximum Capacity. The maximum flow rate at which a meter may run without losing 

measurement. 

Maximum Flow. The meter's maximum flow (Qmax) capacity. 

Meter Accuracy. The degree to which a meter correctly measures the volume of gas passing 

through it, determined by comparing the volume registered by the meter with that registered 

by the prover. 

Minimum Flow. The minimum flow rate (Qmin) at which the accuracy falls in a defined 

tolerance range. 

MODBUS. A serial communication protocol used by the Dattus meter. 

Non-volatile Memory. Data memory not dependent on battery voltage for persistence. 

Optical Port. Programming and communications port located on the meter's front face. 

Pressure. Force per unit area applied to a surface. Pressure = Force / Area 

Prover. Device for measuring the accuracy of gas meter registration. 

Rangeability.  A ratio (Qmax/Qmin) expressing the flow range in which a meter accurately 

measures within a defined set of accuracy parameters (i.e., a range of 50:1 for 100 ± 1% 

accuracy range). 

Rated Capacity. The rated flow rate at which a meter may operate. 
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Readout. LCD, index, register - The device displaying the gas volume passing through the 

meter. 

SCF. Standard Cubic Foot.  That quantity of gas which under an absolute pressure of 14.73 

psia and at a temperature of 60°F (base conditions) occupies a volume of one cubic foot. 

Seal(s). A device designed to give evidence of meter tampering. 

Specific Gravity. Ratio of the density of gas to the density of air (under equivalent pressure 

and temperature conditions). 

Start Flow. The minimum flow rate required for gas flow registration. 

Transfer Prover. A device used to determine a meter's accuracy under test by comparing its 

reading against the reading obtained from a calibrated reference meter connected in series 

with the meter under test. 

Transition Flow Rate. The flow rate (Qt) at which the error channel will open up to a wider 

band. 

Uncorrected Volume. Actual metered volume before any pressure or temperature 

compensation. 
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